# Table of Contents

## Introduction
- What is WYNN? .......................................................... 1
- WYNN Wizard and WYNN Reader .................................. 2
- What’s New in WYNN .................................................. 3
- What’s in this Box? ..................................................... 9
- Online Help .............................................................. 10
- Contacting Freedom Scientific ....................................... 13

## WYNN Single-User and Non-Network Multi-User Installation ....... 15
- Before You Begin ..................................................... 15
- WYNN Installation Process ......................................... 16
- Microphone Installation ............................................... 21
- Uninstalling Previous WYNN Software ............................. 21

## Network WYNN Installation ........................................... 23
- Network WYNN System Requirements ............................... 24
- License Server Installation and Configuration Overview .......... 25
- Installing the Network WYNN Server Components .................. 30
- Configuring User Groups and Folder Permissions ................... 32
- Installing WYNN on a Client Computer ............................. 37
- WYNN Client Installation Process .................................. 38

## Getting Started .......................................................... 42
- Starting WYNN ......................................................... 42
- Creating a New Document ............................................ 45
- Opening an Existing WYNN Document ............................... 45
- Opening Files Using the WYNN User Files Shortcut ................. 47
- Creating WYNN Files Using the Freedom Import Printer .......... 48
- Switching between Files Using the NavBar ........................ 50
- Increasing the Number of Open Documents ........................ 51
- Scanning a Document into WYNN .................................... 52
- Reading a Document .................................................. 55
- Switching Between Exact View and Text View ....................... 57
- Opening Multiple Voice Notes and Text Notes ..................... 59
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing a Document’s Color Settings</td>
<td>167</td>
</tr>
<tr>
<td>Converting Documents to MP3 or WAV File</td>
<td>169</td>
</tr>
<tr>
<td><strong>Student Exercise Guide</strong></td>
<td>172</td>
</tr>
<tr>
<td>Cutting or Copying and Pasting Text</td>
<td>172</td>
</tr>
<tr>
<td>Creating a Vocabulary List Using Bookmarks</td>
<td>173</td>
</tr>
<tr>
<td>Finding a Word in the Dictionary</td>
<td>176</td>
</tr>
<tr>
<td>Finding a Word in the Thesaurus</td>
<td>178</td>
</tr>
<tr>
<td>Hearing Text as You Type</td>
<td>179</td>
</tr>
<tr>
<td>Controlling What WYNN Speaks</td>
<td>181</td>
</tr>
<tr>
<td>Highlighting Text</td>
<td>183</td>
</tr>
<tr>
<td>Listening to Voice Notes</td>
<td>187</td>
</tr>
<tr>
<td>Making Text Bigger</td>
<td>187</td>
</tr>
<tr>
<td>Masking a Document</td>
<td>188</td>
</tr>
<tr>
<td>Opening a Web Page Using WYNN</td>
<td>190</td>
</tr>
<tr>
<td>Organizing Ideas with Outlines</td>
<td>199</td>
</tr>
<tr>
<td>Predicting the Next Word</td>
<td>201</td>
</tr>
<tr>
<td>Printing a Document in WYNN</td>
<td>202</td>
</tr>
<tr>
<td>Proofreading Your Writing Using Speech</td>
<td>203</td>
</tr>
<tr>
<td>Reading Syllables</td>
<td>204</td>
</tr>
<tr>
<td>Check Your Spelling as You Type</td>
<td>205</td>
</tr>
<tr>
<td>Spell Checking Your Document</td>
<td>207</td>
</tr>
<tr>
<td>Spelling a Word</td>
<td>209</td>
</tr>
<tr>
<td>Choosing the Correct Word</td>
<td>210</td>
</tr>
<tr>
<td><strong>System Requirements</strong></td>
<td>213</td>
</tr>
<tr>
<td><strong>WYNN Shortcut Keys</strong></td>
<td>216</td>
</tr>
<tr>
<td>General Commands</td>
<td>216</td>
</tr>
<tr>
<td>Speech Commands</td>
<td>216</td>
</tr>
<tr>
<td>File Management Commands</td>
<td>217</td>
</tr>
<tr>
<td>Reading and Editing Commands</td>
<td>217</td>
</tr>
<tr>
<td>Mark-up Commands</td>
<td>218</td>
</tr>
<tr>
<td>Scanning Commands</td>
<td>219</td>
</tr>
<tr>
<td>Study Tools Commands</td>
<td>219</td>
</tr>
<tr>
<td><strong>WYNN Menus</strong></td>
<td>220</td>
</tr>
</tbody>
</table>
Activation Options ......................................................................................................................... 227
Starting the Activation Process ........................................................................................................ 228
Activating by Telephone .................................................................................................................... 229
Activating by FAX ............................................................................................................................ 233
Activating using FSActivate.com ..................................................................................................... 237

Activating the License Server through a Software Firewall .................................................. 241
General Overview ........................................................................................................................... 241
Configuring Windows Firewall ....................................................................................................... 243

Quick Reference ............................................................................................................................. 248
User Permissions ............................................................................................................................. 248
Network Authorization tools ......................................................................................................... 249
WYNN Folders and Subfolders ........................................................................................................ 251

Index ............................................................................................................................................... 254
Introduction

What is WYNN?

WYNN (What You Need Now) is a software program for people who struggle with reading and writing. The features in WYNN allow you to:

- Scan documents, such as textbook passages, memos, or magazine articles, into WYNN and save them
- Open a document or Web page and have WYNN read it aloud to you
- Easily change the way the text looks to make it easier to read
- Use writing tools to make writing assignments easier
- Use study tools to help you learn

WYNN uses a series of color-coded toolbars to help you quickly access reading and writing assignments. You can do almost everything using the buttons on the toolbars that appear across the top of the screen. Refer to Getting to Know WYNN for more information.
WYNN Wizard and WYNN Reader

Two versions of WYNN software are available: WYNN Wizard and WYNN Reader.

**WYNN Wizard** is a full-featured application that includes:

- Optical character recognition (OCR), which allows you to scan and read pages, as well as read existing word processing and text files
- Document composition and editing tools like word prediction, spell checking, and homophone recognition
- The ability to browse the World Wide Web to assist with topic research
- Traditional study aids like highlighting, bookmarking, outlining, and dictionary and thesaurus usage
- Visual and auditory adjustments to make it easier to read and comprehend documents
- Single-user or network licensing available

**WYNN Reader** includes the same features and functionality that are in WYNN Wizard, except for scanning and OCR capabilities. Use WYNN Reader to read electronic documents, create or edit documents, and browse the Internet for document research.

Single-User and Network Versions

Both WYNN Wizard and WYNN Reader are available as single-user or network licensed products. The single-user version easily installs onto a single computer, while the network version allows as many clients as possible, based on the number of licenses purchased, to use the software at once over a local area network (LAN).
What's New in WYNN

WYNN has many exciting new features for our users.

**RealSpeak™ Solo and ETI-Eloquence™ Speech**

During a typical full product installation, the following RealSpeak (SAPI 5) voices are automatically installed from the WYNN program CD:

- US English Samantha
- US English Tom
- UK English Emily
- Mexican Spanish Paulina
- Canadian French Julie

The following RealSpeak voices are also available on the RealSpeak Voices CD, which is standard with the full WYNN 5.10 version.

- UK English Daniel
- Australian English Karen
- Australian English Lee
- Spanish Isabel
- Mexican Spanish Javier
- French Canadian Felix
- French Virginie
- French Sebastien
- German Steffi
SAPI 4 support is maintained with the introduction of ETI-Eloquence voice synthesizers, which are also available for installation from the WYNN program CD. For steps describing how to change voice settings and speech synthesizers, refer to the Changing WYNN’s Voice or Language Settings topic in the Getting Started section.

**New Web Features and Improvements**

The Web browsing module has been redesigned to support learning on the Web and the latest Web technologies.

- Mouse-over a Web link and WYNN can read the hyperlink text to you.
- Highlighting text on Web pages as you would a normal document
- Creating lists from highlighted text on Web pages
- Extracting text from Web pages to a WYNN document
- Configurable Web spotlighting and WebMasking
- View Web Favorites and History in the left sidebar
- Talking online forms completion
- Java and Flash compatibility
- Increased support for online courseware such as Blackboard/WebCT
- Read and create e-mail using Web-based e-mail services
- Updated Web toolbar which now includes the **Dictionary**, **Highlight**, and **Lists** buttons
- Easy PDF viewing
- Built in Pop-up blocker
• Limiting the number of open Web pages

• Selectable **Form-Filling Mode** to aid in form and e-mail completion

• **Go to Web** button opens a new Web document

**Easier File Navigation**

WYNN now uses a left side navigation bar – the **NavBar** – to navigate between your open documents. You can close the documents and have the titles read to you. Use this new feature to switch between your open documents with a click of a button.

**Digital Talking Books**

DAISY books and NIMAS-conformant documents are now supported within WYNN.

Digital Talking Books: DAISY books and NIMAS documents are now supported. To select and open a DAISY or NIMAS document, do the following:

1. From the File menu, choose Open, and then select DAISY/NIMAS from the Files of Type list box.

2. Next, select a chapter that appears in the dialog, and choose Open. WYNN displays and reads the text for you.

**OCR Support**

WYNN uses version 7.0 of the popular FineReader optical character recognition (OCR) software. FineReader provides excellent text recognition for scanned documents, with significant improvements in word accuracy and format retention. FineReader high-speed scanner support is only available in WYNN Wizard.
Printing Enhancements

More printing options have been added to WYNN, including the ability to include or exclude highlights and other markup when printing.

Support for Windows 7

Beginning with version 5.1.118, WYNN supports the following Windows operating systems: Windows 7 (64-bit and 32-bit), Windows Vista (64-bit and 32-bit), and Windows XP (32-bit).

For Windows 7, an update to the Freedom Import Printer is required. A free update can be downloaded from the Freedom Scientific Web site for those who already own WYNN. For new purchases beginning December, 2009, an additional CD is included with the shipping product. That CD, the Freedom Import Printer updater, must be installed after installing WYNN on the computer. The updater is only needed for Windows 7.

Installing and Activating with Window 7 and Windows Vista

When installing WYNN on a Windows 7 or Windows Vista computer, you should turn off the User Account Control (UAC) before installing the WYNN program. The UAC should also be off when you activate your license for WYNN. To activate your license, start the WYNN program. The WYNN Activation dialog box will appear. Follow the instructions to activate the software. Once the activation process is complete, you should restore UAC.

Installing through a Firewall

If your organization has a firewall, you may need to disable the firewall temporarily during activation. Instructions for doing this can be found in Activating the License Server through a Software Firewall on page 241.
Support for NetBook Computers

NetBooks are very small laptop computers with minimal features to keep price and weight down. NetBooks are mobile devices specifically designed to be your second computer, not your primary computer, to help you connect to the Internet. NetBooks can do word processing, spreadsheets, Internet work, and other common tasks, such as viewing digital videos and photos or listening to music. Most units come with Windows XP Home, although some have a special version of Linux, and a few use Windows Vista. They all have processors running at more than 1 GHz. They usually have wireless capability and 2 or 3 USB ports. They use lithium batteries and will operate for 4 to 10 hours on a charge. Many manufacturers produce NetBooks today, including Toshiba, HP, Lenovo, Asus, Acer, and others.

NetBooks do not have a CD-ROM or other external drive. They usually have a smaller keyboard, with less space between the keys. They often do not have external video connections. They do not come with a mouse, but have a touch pad. They have very small screens; screen size ranges from 9 to 11 inches, with most being about 10 inches. That means they have lower screen resolutions. Their screen resolution is also a different ratio from that of desktop or laptop computers. For example, typical laptop or desktop monitor resolution is 1024 x 768 or higher. Typical NetBook resolution is 1024 x 600.

NetBooks are priced (as of August, 2009) between $300 and $500. This includes the configuration listed above. Some NetBooks are priced lower because they have a smaller battery (that works for only 3-4 hours) or smaller hard drive. Occasionally less expensive NetBooks have lower screen resolution.

How does WYNN work with NetBooks?

WYNN works well with NetBooks as long as the NetBook meets WYNN's minimum system requirements. Most NetBooks meet these requirements since WYNN works with XP Home and uses far less than the basic NetBook system configuration.
Two notes about WYNN and NetBooks:

- Since NetBooks do not have CD-ROM drives for installation, it is easiest to copy the WYNN program CD to a USB drive, then install from there. A 1 GB USB has sufficient space for the files on the WYNN program CD.

- One NetBook has lower screen resolution than normal, at 1024 x 576. This is the HP Mini 110 in its basic configuration. This screen resolution does not meet WYNN's 800 x 600 minimum requirement. A version of the HP Mini 110 is available with higher screen resolution for a nominal additional charge ($30 at the time of this writing). That addition makes the HP Mini 110 meet WYNN's minimum requirements.

Research Supporting Voice Notes and Text Notes, Other Research, and White Papers

A multitude of research projects has validated many of the features in WYNN. A recent article in JSET, Journal of Special Education Technology, presents research results that indicate statistically significant improvement in performance of both special education and regular education students using WYNN's digital note-taking supports in science subjects. The article discusses both WYNN's Text Notes and Voice Notes. Other research supports additional features in WYNN. The Learning Systems Group of Freedom Scientific has published a white paper on this research. For more information, visit our Web site, at http://www.freedomscientific.com/lsg/resources/Scientific-Research-WP.asp

Training Resources

Many opportunities exist for training and professional development for WYNN.
Tutorial Module CD

The WYNN Tutorial CD contains ten informative videos, each targeting specific features and uses of WYNN. Each tutorial runs between three and nine minutes, making the videos concise, yet informative, allowing users to easily navigate to the specific information they need. Every video includes the educational benefit of the feature as well as specific guidance for how to use the feature, making it an ideal tool for classroom teachers.

Atomic Learning Videos

Atomic Learning videos are short, one- to two-minute clips that offer a micro-united approach to learning. Users can choose from 66 different videos on WYNN. Examples of video titles are "Browsing the Web," "Using Word Prediction," "Converting a Document to Audio," and "Creating a Vocabulary List using Bookmarks." Atomic Learning is a subscription-based service.

For more information, see the Atomic Learning Web site at http://www.atomiclearning.com/k12/en/wynnpc.

Webinars

Our knowledgeable staff members give free Webinars on a variety of topics related to WYNN. For more information, contact one of our Regional Managers. Please see the Contact Us page at http://www.freedomscientific.com/lsg/about/contact_us.asp.

What’s in this Box?

The following items are in your WYNN package. If you discover damaged or missing items, please contact your retailer.
• CD wallet containing one WYNN program CD and several speech synthesizer software CDs. The CD wallet may contain an Authorization CD. You may receive authorization labels and a cover letter depending on how you purchased WYNN.

• Microphone

• WYNN User’s Guide

• Authorization number labels and cover letter (Non-network Multi-user version only). If you receive multiple boxes, your authorization labels will be in one box marked with a label.

**Online Help**

There are several ways to get help when using WYNN.

• [Help topics](#)

• [Status Bar Help](#)

• [Context-Sensitive Help](#)

• [Readme file](#)

**Help Topics**

To open online help, do one of the following:

• Press the F1 key, or

• Click the Help menu, and then click the WYNN Help command.
The following illustration shows the various components of the Help window that appears.

Use the **Table of Contents** (left window pane), the **Index** or **Search** tabs, and the topic links (right window pane) to select and view an area of interest. When you are done, click the **Close** button – \[X\] – on the title bar to close the online Help.

**Status Bar Help**

When you move the mouse pointer over a menu command, the status bar at the bottom of the window displays a short description of the command.
Context-Sensitive Help

WYNN’s context-sensitive help shows information about a specific option or button in a dialog box. There are three types of context-sensitive help: the **Question Mark** button, the **F1** key, and the **What's This?** button.

To use the **Question Mark** button, do the following:

1. Click the **Question Mark** button – ? – in the upper right corner of the dialog box, which changes the appearance of the mouse pointer.

2. Click any option in the dialog box. WYNN displays a context-sensitive help message for that item.

To use the **F1** key, do the following:
1. Select an item within a dialog box, and press the **F1** key. WYNN displays a context-sensitive help message for that item.

To use the **What’s This?** button, do the following:

1. Use your mouse to right click within the dialog box. The pointer becomes a floating **What’s This?** button. For example:

   ![What's This?](image)

2. Click the button on an item to open the context-sensitive help message for that item.

---

### The Readme File

WYNN’s Readme file gives you the latest software release information. It is available during product installation and, later, in the WYNN program group.

To open and read the Readme file:

1. From the Windows **Start** menu, click **All Programs** or **Programs**, and then point to the **WYNN program** folder.

2. Click the WYNN Readme shortcut to open the Readme file.

---

### Contacting Freedom Scientific

Use the following options to contact Freedom Scientific’s support staff.

- Technical Support e-mail: Support@FreedomScientific.com
- Technical Support Telephone: (727) 803-8600
When contacting Freedom Scientific, be prepared to provide the following information:

- Product name, version number, and serial number
  (This information appears in the **About** dialog box, which is available from the **Help** menu.)

- Type of computer hardware you are using

- Version of Windows running on your machine

- Exact wording of any messages on your screen

- What you were doing when the problem occurred

- Steps you have taken to solve the problem

Technical support is available Monday through Friday from 8:30 am to 7:00 pm, Eastern Time (ET).
WYNN Single-User and Non-Network Multi-User Installation

Important:
The procedures in this chapter assume that you can access the Internet from your computer for software activation. If you do not have Internet access, refer to Activation Options for alternate activation procedures.

This chapter describes how to:

- Copy your WYNN Authorization number from the Authorization CD to your computer.

Note: The single-user version uses the Authorization CD, while the Non-Network Multi-User (NNMU) version uses Authorization numbers printed on supplied labels.

- Install the WYNN Wizard or WYNN Reader application software onto your computer
- Install the speech synthesizer software on your computer
- Activate your WYNN software

Note: If you are installing the network version of WYNN, refer to Network WYNN Installation.

Before You Begin

- Verify the minimum system requirements
- Verify that you have an Internet connection (required to activate your software quickly using the Internet)
- Determine if you are installing the non-network multi-user or single-user WYNN version versus the WYNN network version.
Uninstall any previous version of WYNN (see Uninstalling Previous WYNN Software)

WYNN Installation Process

WYNN installation is a four-step process.

- First, you must insert the WYNN Authorization CD and copy the Authorization number to your computer (single-user program only).
- The next step is to install the WYNN application using the WYNN program CD.
- Once the application is installed, remove the WYNN program CD, and insert the speech synthesizer CD. Install as many of the voices as you like.
- Finally, open the WYNN application and activate the program. Activation is a one-time task that enables and registers your single-user or NNMU software with Freedom Scientific. You must activate the application before you can use WYNN.

Copying the WYNN Authorization Number

The Authorization CD contains a 20-digit alphanumeric number that you must transfer to your computer. The Authorization number is part of the Internet License Manager (ILM) activation process. You must activate your WYNN application before it can be used.

Important:
The WYNN NNMU program does not use an Authorization CD. Instead, its Authorization numbers are printed on a label sheet. Assign one label to each computer that will use the WYNN program, and enter that number into the Authorization number field when prompted. Refer to Activating WYNN for more information.
To copy the Authorization number for the WYNN single-user program:

1. Close all applications and insert the WYNN Authorization CD into your CD-ROM drive.

   The Authorization Number dialog appears and shows your Authorization number.

   ![Authorization Number](image)

2. Click OK.

3. Remove the Authorization CD and insert the WYNN application CD.

**Installing WYNN Wizard or WYNN Reader**

The following describes how to install the single-user and non-network multi-user versions of WYNN Wizard and WYNN Reader.

**Note:** Always install the WYNN application before installing the speech synthesizer software, which is provided on separate installation CDs.

To install the WYNN Wizard or WYNN Reader application:

1. After inserting the WYNN application CD, the WYNN InstallShield wizard window appears.

   Click **Next** and follow the on-screen instructions.
2. When installation is complete, the InstallShield Wizard Complete window appears.

**Note:** When performing an upgrade, it may be necessary to reboot your computer. Click Yes when prompted if this is the case.

3. Click **Finish**.

The WYNN application is installed, and the WYNN application and WYNN Documents folder icons appear on your desktop.

4. Remove the WYNN application CD, and insert the speech synthesizer software CD.

### Installing the Speech Synthesizer

Install the speech synthesizer software after you finish installing the WYNN application. To install the speech synthesizer, do the following.

1. After inserting the speech synthesizer CD into your computer’s CD-ROM drive, let the auto-run feature start the installation.

2. Follow the on-screen instructions.

3. Repeat these steps to install additional voices. Remove the CD from your computer when complete.

**Note:** You must activate the WYNN application before you can use it. Refer to the next section for WYNN activation procedures.
Activating WYNN

**Note:** The following procedure assumes that your computer has Internet access. If you cannot connect to the Internet, refer to the [Activation Options](#) section for more information.

1. Open WYNN by clicking the WYNN desktop icon or selecting the WYNN program from the Start button.

2. The WYNN Activation dialog box appears the first time you open WYNN. Click **Activate**.

3. The WYNN activation options appear. Choose **Now, using the Internet (Recommended)**, and click **Next**.

4. The Authorization Number edit box appears and contains your Authorization number. Click **Next**.
Important:

For **NNMU installation**, the Authorization Number edit box is blank. Enter the Authorization number that appears on the Authorization number label sheet into the edit box, and then click **Next**.

For the single-user version, the Authorization number also appears on your WYNN product packaging. Type the number into the edit box if it does not automatically appear in the Authorization Number edit box.

This process may take several minutes to complete. During this time, the Processing Request dialog appears.
You may be prompted to register your software. If you have not registered your software, you are asked to do so now. Registering lets you receive technical support. Choose **Register Now** and complete the online registration form by following the instructions provided.

5. If the activation is successful, a confirmation message appears. Click **Finished**, which completes the activation.

If the activation fails, a detailed error message appears that recommends you verify or reenter your authorization code, or that you contact Freedom Scientific for assistance.

**Microphone Installation**

To install the microphone:

1. Assemble the microphone and microphone stand.

2. From the rear of the computer, locate the MIC jack on the sound card, and plug the microphone into the MIC jack.

3. If your microphone has an on/off switch, use it to turn the microphone on or off.

**Uninstalling Previous WYNN Software**

To uninstall the WYNN application:

1. Make sure that your existing version of WYNN is not running.

2. Do one of the following depending on your version of Windows:
   - From your desktop, click the **Start** button, click **Control Panel**, and double-click **Add or Remove Programs**.
...OR...

- From your desktop, click the **Start** button, point to **Settings**, click **Control Panel**, and double-click **Add or Remove Programs**.

3. Select **WYNN Wizard X** or **WYNN Reader X** (where X is the software version number) in the list of programs and click the **Change/Remove** button.

The WYNN InstallShield Wizard appears. Follow the on-screen instructions to uninstall your WYNN software. You may also be required to reboot your computer during the uninstall. If this is necessary, a message appears stating that you must reboot.

**Note:** During this procedure, a message appears stating that the Freedom Import Printer cannot be removed. This is normal.

Click OK to continue.
Network WYNN Installation

Note: This chapter is intended for network administrators. It assumes that you are familiar with computer networks, user groups, user accounts, and user permissions. You must have Administrator or Power User access on all machines where the server, license server, and client components are installed. A Troubleshooting and a Quick Reference section are included at the end.

Note: You must first uninstall previous versions of WYNN using Add/Remove Programs, not using the WYNN 5 CD.

Network WYNN Installation consists of four major parts.

Part 1 is the installation and activation of the Internet License Manager (ILM) software. This allows you to designate a computer running Windows on the network as the ILM license server. This computer issues tokens to the WYNN clients. The number of license seats purchased determines the number of tokens available to client computers on the network.

Part 2 is the installation of WYNN components onto the WYNN server. This consists of installing software from the Network WYNN CD to the WYNN Wizard or WYNN Reader directory on the server.

Part 3, which occurs on the WYNN server, is the creation of a WYNN user group and setting permissions on specific WYNN folders. These folders appear during WYNN server component installation.

Part 4 is the installation of the WYNN application and speech synthesizer from the server to the client computers.

Tip: Make sure your user permissions are set up correctly or users may have problems saving their profiles, settings, and documents.
Network WYNN System Requirements

License Server Requirements

- Windows® 98 or higher
- Pentium processor
- 64 MB of RAM
- 800X600, 16-bit high color display
- TCP/IP Network connectivity

WYNN Server Requirements

- Windows 2000, 2003 Server, XP, or Novell Netware 6.0
- 650 MB of disk space on the server (2.5 GB with RealSpeak Solo Voices)
- Additional disk space for user folders

Client Requirements

Network WYNN clients have the same requirements as the Stand-alone version or single user version. However, Network WYNN clients also require:

- TCP/IP Network connectivity to the License Server
- Microsoft Network Connectivity between the client and the WYNN server.
License Server Installation and Configuration Overview

A WYNN Network Authorization CD is supplied with the Network WYNN version. The following overview describes the three primary steps to installing and configuring a license server computer.

- Select a license server computer

  You must designate one Microsoft Windows-based computer on the network to be the license server. This can even be the WYNN server. Install the license server on a networked computer that is not running the WYNN client. Make sure that this computer is always accessible.

  The license server handles requests for tokens. A token allows a WYNN client to use WYNN. The license server issues tokens to the requesting clients until there are no more tokens available. The number of available tokens depends on how many license seats were purchased. For example, if 10 seats are purchased, only 10 simultaneous WYNN sessions are available. If an eleventh computer tries to use the WYNN application, it is denied access to the application until a license seat becomes available.

- Install the license server software

  The WYNN Network Authorization CD contains the network authorization utilities, documentation, and tools. Insert the CD into the computer’s CD-ROM drive, and follow the on-screen instructions to install the software.

- Activate the license server computer

  This is the only computer that requires software activation. The other WYNN client computers do not require authorization or activation since they obtain tokens from the
license server. For activation procedures, refer to Activating the License Server on page 27.

Installing the License Server Software and Network Authorization Tools

The following process describes how to install the license server, which authorizes client computers to use your Freedom Scientific product. This installation also creates a program folder in your Start menu that provides access to the Network Authorization documentation and tools.

1. To begin the installation, insert the WYNN Network Authorization CD into your computer’s CD-ROM drive. The Network Authorization Utilities dialog box appears. Choose Install to continue.

   Note: If the installation does not begin automatically, select the Start button, choose Run, type “D:\Setup.exe” and press ENTER. If your CD-ROM drive is not D, then substitute the correct letter.

2. The Network Authorization Utilities installation status appears. The installation briefly pauses, and then launches the InstallShield Wizard for the SentinelLM Server.

3. The InstallShield Wizard for SentinelLM Server starts. Choose Next to begin the license server installation.

   Note: You can only install the license server on a computer that runs Windows 98 or later. The license server does not support other operating systems such as Novell, UNIX, Linux, and so on.

4. Read the license agreement. If you accept the terms and conditions in the agreement, choose Yes.
By default, the license server installs in C:\Program Files\Rainbow Technologies\SentinelLM 7.2.0.6 Server. If you want to install the license server in a different folder, choose **Browse** and select a new folder. Choose **Next** to continue with the installation.

5. Choose **Finish** when installation of the SentinelLM Server is complete. The Network Authorization installation status menu appears again.

6. Choose **Finish** when this installation of the Network Authorization Utilities is complete.

The Network Authorization tools and license server are now installed. If you are using Windows XP, NT, or 2000, the “SentinelLM” service is automatically added to your Windows Services.

The installation creates a new folder in your **Start** menu called **Freedom Scientific**. View the **Quick Reference** section for detailed descriptions of each Network Authorization tool.

**Activating the License Server**

After installing the license server and Network Authorization tools, you must then activate your Freedom Scientific product license. To do this, you must request an Activation License code from Freedom Scientific. You can use the Internet to receive your Activation License code quickly and easily.

**Note:** If you are upgrading from Network WYNN 4.0 to Network WYNN 5.0 you must also update your authorization using the steps below.

Perform the following to activate your Freedom Scientific product:

1. From the Start menu, choose Programs or All Programs, Freedom Scientific, Network, and Update WYNN Wizard Authorization or WYNN Reader Authorization.
2. Choose the **Activate** button to begin the activation.

3. Select the **Now, using the Internet (RECOMMENDED)** option to specify that you want to use the Internet to acquire your Activation License code. Choose **Next** to continue.

![Activation Screen]

4. Your 20-character Authorization number is automatically inserted into the **Authorization Number** edit box. If your Authorization number is not shown, type it into the edit box. (Your 20-character Authorization number appears on your WYNN CD package.) Choose **Next** to continue.
5. You may be prompted to register your software. Registering lets you receive technical support. Choose Register Now and complete the online registration form by following the instructions provided. You can choose to register later, but you must register the next time you activate the software on any computer.

6. After you submit your registration, Internet License Manager (ILM) attempts to activate the software. This process may take several minutes. When the activation is successful, choose Finish.

**Tip:** If Internet License Manager cannot activate the software, you may need to reconfigure your firewall. For more information, see Activating through a Firewall.

7. Start the WLMAdmin utility by opening the Start menu and choosing Programs or All Programs, Freedom Scientific, Network, and Server Administration. If the WLMAdmin utility is running, quit the program and then restart it. You can use this utility to monitor where the license(s) reside and which users are using tokens.
You can now install the Network WYNN Server Components.

Installing the Network WYNN Server Components

**Note:** If you are upgrading from Network WYNN 4.0 to Network WYNN 5.0, disable the old Users share by right-clicking on the folder, selecting Properties, navigating to the Share tab, and selecting Do not share this folder.

Network installation requires that you install all server components from the Network WYNN CD to the server. During this process, all client installation files are copied to the server and several WYNN folders are created.

1. Insert the Network WYNN CD into the server’s CD-ROM drive.

**Important:**

WYNN’s server components installation program is located in the CD’s root folder. Installation must run from this location. Do not copy and run the installation components from a different medium.

The Auto-Run feature starts and the WYNN installation wizard screen appears. Click the **Next** button.

**Note:** If the CD does not automatically launch, navigate to your CD-ROM drive and select Setup.exe.

2. Read the License Agreement. If you accept the terms, choose **Yes**.

3. Enter a user name and company name, and then select **Next**.
4. By default, Network WYNN installs in C:\WYNN5NW. If you want to install it in a different folder, choose **Browse** and select a new folder. Choose **Next** to continue with the installation.

5. By default the document storage location is C:\WYNN5NW\Users. This location must be shared so that all users can access it. Make sure the storage location is shared and then select **Next** to continue.

6. If the target directory has not yet been shared, a Yes/No prompt appears stating that the selected location must be shared. Select **Yes** to automatically share the target directory, or select **No** to manually share the target directory.

   When installation is complete, check the permissions for the shared directory. Refer to the **Sharing a Folder** section for sharing and permission procedures.

   **Note:** If you already have a Users share, either disable the share or choose a new folder name.

7. Click the **Finish** button when installation is complete.

   If the correct user permissions are in place, you can run the WYNN Wizard or WYNN Reader installation from the client by connecting to the server and running the setup.exe file.

8. Refer to **Installing WYNN Wizard or WYNN Reader Software** for client installation procedures.

   During installation, several new folders and subfolders are created on the server. For a description of these folders, refer to the **Quick Reference** section.
Configuring User Groups and Folder Permissions

Users must be able to access certain folders to use Network WYNN. You can create one user group and set the access for that group, or you can create many users and then set the folder access for each user.

Creating a User Group

Create a WYNN user group to easily add students who will use the WYNN application. You can allow individual users to access the WYNN folders, but you will have to set folder permissions for each user. If you create a group, you only set folder permissions once for the group.

1. Navigate to the Control Panel.
2. Select Administrative Tools.
4. Expand Local Users and Groups and select Groups.

5. In the Action menu (ALT+A) choose New Group or right-click in the right panel and select New Group.

6. Enter the Group name ("WYNN Users").

7. Choose Add to add members

8. Click Create to create the group

**Sharing the Users and WYNN5nw Folders**

The Users folder and the WYNN5nw folder must be shared for WYNN to function correctly. The Users folder’s permissions must be set to Full Control, Change, and Read. The WYNN5nw folder’s permissions must be set to Change and Read.

To share the folders, follow these instructions:

1. Use Windows Explorer to locate the folder.

2. Next, right-click on the folder and select Properties.
3. In the **Sharing** tab, select the **Share this folder** option.
4. Select the Permissions button and choose **Full Control**, **Change**, or **Read** depending on which folder you are sharing.

![Permissions for WYNN5nw dialog box](image)

**Note:** If you want the permissions to affect only the WYNN user group, add or select the group. While the group is selected, set the permissions.

5. Select the OK button twice to close the Permissions and User Properties dialog boxes.

**Setting the NTFS Permissions**

You must also set the NTFS permissions of four folders on the WYNN server—WYNN5nw, License, Users, and WYNN Reader or WYNN Wizard.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Full Control</td>
</tr>
<tr>
<td>WYNN5nw</td>
<td>Read &amp; Execute, List Folder Contents, and Read</td>
</tr>
</tbody>
</table>
To set the NTFS permissions on the folders, follow these instructions:

1. Use Windows Explorer to locate the folder.
2. View the folder properties.
4. Select your WYNN User group.
5. In the Permissions section, choose the permissions.
Installing WYNN on a Client Computer

The final part of network installation requires that you install the WYNN application onto the client computers by running the appropriate Setup.exe file that resides on the server. Do not run the client setup from the CD.

You do not need to perform additional authorization procedures for these computers. Each time the software is started on the client, it automatically searches for the license server and obtains an authorization token.

The number of tokens available depends on the number of users permitted by your license. For example, if you purchase a license for five users, your license server has five tokens available. Each time a user starts the software, the license server assigns the client computer a token. Once all tokens are assigned, no additional clients can receive authorization.

If you need your license to support additional users, contact your local distributor or Freedom Scientific to purchase additional seats.

To run the Setup.exe file from the server, follow the procedures described in the **Installing WYNN Wizard or WYNN Reader** section of the WYNN installation chapter.
Adding the Environment Variable LSFORCEHOST

**Tip:** It is recommended that you add the environment variable LSFORCEHOST to the client computers and set it to the name or IP address of the SentinelLM license server. When the Freedom Scientific program starts, it will only search for a product license on the specified computer. If you have distributed the license over more than one license server and you want the program to search for the first available token, do not add this environment variable. For more information, refer to the *System Administrator’s Guide*, which is a Network Authorization tool that you installed earlier.

Do the following to add the environment variable:


2. In the System Properties dialog box, select the Advance tab, and choose the Environment Variables button.

3. Select the New button that appears in the System Variables area, and then enter LSFORCEHOST in the Variable name field and the server name or IP address in the Variable Value field. Click OK to close the dialog box and save the changes.

**WYNN Client Installation Process**

WYNN installation is a two-step process.

- The first step is to install the WYNN application by running the Setup.exe file on the client from the WYNN server.

- Once the application is installed, determine if you want to install the speech synthesizer. If you do, insert a speech synthesizer CD. Install as many of the voices as you like.
Installing WYNN Wizard or WYNN Reader

The following describes how to install the network license version of WYNN Wizard or WYNN Reader.

**Note:** Always install the WYNN application before installing the speech synthesizer software, which is provided on separate installation CDs.

To install the WYNN Wizard or WYNN Reader application:

1. From the client computer, use Windows Explorer to browse to the WYNN setup file using one of the following paths:

   For WYNN Wizard:
   
   \`\`\`\fileserversonline\WYNN5nw\WYNN Wizard Eng\Setup.exe
   
   Where `fileserversonline` is the name of the WYNN server.

   For WYNN Reader:
   
   \`\`\`\fileserversonline\WYNN5nw\WYNN Reader Eng\Setup.exe
   
   Where `fileserversonline` is the name of the WYNN server

   **Note:** Make sure you use the UNC share path (\`\`\`\fileserversonline\WYNN5nw\...). This is the path that WYNN will use to connect to the WYNN server.

2. The WYNN InstallShield wizard window appears.

3. Follow the on-screen instructions.

4. When installation is complete, the InstallShield Wizard Complete window appears.
Network WYNN Installation

Note: For certain installations, such as an upgrade, it may be necessary to reboot your computer. Click Yes when prompted if this is the case.

5. Click Finish.

The WYNN application is installed, and the WYNN application folder icon appears on your desktop.

6. Do one of the following:

- If you are installing the speech synthesizer on this client, go to the Installing the Speech Synthesizer section and follow the installation procedures.

- If you are not installing a speech synthesizer on this client, go to the next client computer, and repeat steps 1 through 3 to install the WYNN application.

Installing the Speech Synthesizer

Note: When performing installation on multiple clients, you may want to copy the contents of the speech synthesizer software CDs to your network server so that these files are readily accessible to you when installing the software on the client computers.

Install the speech synthesizer software after you finish installing the WYNN application.

To install the speech synthesizer:

1. Do one of the following:
• After inserting a speech synthesizer software CD into your computer’s CD-ROM drive, let the auto-run feature start the installation.

...OR...

• From the client, browse to the location on the server of where you placed the speech synthesizer files, and select Setup.exe.

2. Follow the on-screen instructions.

3. Repeat these steps to install additional voices. Remove the speech synthesizer software CD from your computer when complete.

4. Go to the next client computer, and repeat steps 1 through 4 of the Installing WYNN Wizard or WYNN Reader to install the WYNN application on another client computer.

**Note:** To select an installed voice, refer to Changing WYNN’s Voice or Language Settings.
Getting Started

This section describes basic tasks that all users can perform to start WYNN, open documents using WYNN, read documents with WYNN, use WYNN's study tools, customize WYNN, and save documents using WYNN.

Starting WYNN

The first time you start WYNN, you must create a unique user name before using the software. Not only does this process create your user name, but it also creates your own user folder, which is your default folder that stores your documents. The default folder uses your user name. For network versions of WYNN, your default user folder is stored on the server.

To start WYNN:

1. Double-click the WYNN Wizard or WYNN Reader application icon that appears on your desktop.

![WYNN Wizard] [WYNN Reader]

or

The User Log-In dialog appears.
2. Do one of the following:
   - If you already have a user name, select it from the list, and click OK. The WYNN application starts, and opens the last file that was open.

   ...OR...

   - If you are a new user:
     
     Type your name in the **Please Sign In Here** edit box.

     Click **OK**. A confirmation window appears.

     ![Confirmation Window]

     Click **Yes**. A process begins that accepts your new user name, creates a default folder for your documents, and starts the WYNN application.

3. The WYNN application starts, your user name appears in the upper right corner of the WYNN window, and the **Welcome to WYNN** file appears.
Multi-User Log In

If another user wants to log in without quitting WYNN:

1. Choose Log in Different User from the File menu or click on the name in the upper right corner.

2. The user can then log in, as previously described, and begin using WYNN.

Note: If only one user will be using WYNN on this computer, you can skip the log in process. To do this, choose Enable Multi-User Logins from the File menu. Enable Multi-User Logins should be unchecked. The next time you start WYNN, you will not be asked to log in. Choose this command again to re-enable multi-user logins.
Creating a New Document

To create a new document:

1. From the blue File Management toolbar, click the New button.

   ![New Button](image)

   A blank page appears. You can type new text into this document, or click the Scan button to add scanned pages to it.

**Tip:** You can also press **CTRL+N** to create a new document.

**Note:** By default, the maximum number of documents that can be open at once is two. If you create a new document while the maximum number of documents is already open, WYNN asks you to save changes to the least recently accessed document and then closes it.

   To change the number of documents you can have open, see the Increasing the Number of Open Documents section.

Opening an Existing WYNN Document

To open an existing document:

1. From the blue File Management toolbar, click the Open button.

   ![Open Button](image)
The **Select a File to Open** dialog appears. All WYNN formatted files saved in your user folder appear. WYNN files use the .WYN and .ARK file extensions.

![Select a file to open dialog](image)

2. Locate the file on your computer, and then click **Open** to load the file.

   If the file you want to open is not shown in the list, use the **Look In** combo box to locate and select a different folder.

### Opening Other Documents

To open files saved in file formats other than WYNN’s default format:

1. From the Files of type combo box, choose one of the following file formats that can be read by WYNN.

   - Microsoft Word (.doc) files
   - Portable Document Format (.PDF) files – WYNN Wizard only
   - Text (.txt) files
   - HTML files
- Rich Text Format (.rtf) files
- DAISY/NIMAS (.opf) files

2. Select the file you want to open.

3. Click **Open**.

When you open a PDF file in WYNN, it becomes available just as if you had scanned it in.

When you open other file types, WYNN displays the contents of these files in the Text View without any special formatting.

To view these files in their original format, open them in the program they are normally associated with.

**Tip:** You can also press **CTRL+O** to open a file.

**Note:** By default, the maximum number of documents that can be open at once is two. If you create a new document while the maximum number of documents is already open, WYNN asks you to save changes to the least recently accessed document and then closes it.

To change the number of documents you can have open, see the **Increasing the Number of Open Documents** section.

**Opening Files Using the WYNN User Files Shortcut**

After installing WYNN, the WYNN User Files shortcut appears on your desktop. It provides fast access to the files in your default WYNN folder.

To open a document using your WYNN Documents shortcut:
1. From the Windows’ Desktop, double-click the WYNN User Files shortcut.

The WYNN folder, which contains your personal default folder, and WYNN’s Shared file folder appears. Your default folder is located in

C:\Documents and Settings\All Users\Documents\WYNN

2. Open your default folder to access your saved files.

Creating WYNN Files Using the Freedom Import Printer

WYNN Wizard includes a virtual printer that provides the ability to convert files from PDF files, or any other file format, to a WYNN document. This virtual printer, called the Freedom Import Printer, shows up on the list of printer drivers in the Print dialog box.

The following topics provide example for opening a PDF formatted file and converting it to a WYNN (.wyn) formatted file using the Freedom Import Printer and WYNN Wizard.
Opening a PDF file from within WYNN

There are two ways to bring PDF files into WYNN Wizard:

- The first is to open the PDF file from within WYNN
- The second is to open Adobe Acrobat Reader and print the PDF using the Freedom Import Printer. This conversion process is described in Converting Files Using the Freedom Import Printer.

To open a PDF using WYNN, do the following:

1. Launch WYNN.
2. From the File menu, choose Open. Then Select a File to Open dialog appears.
3. Change the "Files of type" field to Adobe PDF Documents.
4. Select the PDF file you want, and press the Open button.
5. The file is automatically converted to the WYNN file format.

Converting Files Using the Freedom Import Printer

You can also convert PDF document, or documents from any other file format, into WYNN documents using the Freedom Import Printer. The Freedom Import Printer is only available in WYNN Wizard.

Note: This process also works for converting online PDF files.

1. From any application, open a file you want to open with WYNN Wizard.
2. From the File menu, choose Print. Select Freedom Import Printer as your printer.

3. If desired, specify the range of pages to be "printed."

4. Select OK.

5. The Freedom Import Printer will convert the document to a WYNN file. If WYNN is not open, the Virtual Printer will open it.

   You may wish to save the file as a .wyn file after it is opened in WYNN.

### Switching between Files Using the NavBar

You can use the left side navigation bar (NavBar) to switch between open documents. The NavBar shows all of your open documents arrange by type.

1. Click the File List button.

2. Select the title of the document that you want to view.

   If you right-click on a selected title, you can close the document or have WYNN speak its name.
Increasing the Number of Open Documents

By default, WYNN allows a maximum of two documents to be open at once.

To change this setting, do the following:

1. Click **Settings** from the WYNN menu bar, and click the **General Settings** command.

The **General Settings** property page appears.
2. Enter or select a value in the Maximum Number of Open Documents combo box in the lower right corner.

3. Click the OK button.

Scanning a Document into WYNN

The scanning feature allows you to read and work with printed materials in WYNN. You can create a new document based on a scanned page or insert scanned pages into existing documents. You can also replace existing pages with scanned pages. For additional scanning information, refer to the Scanning with WYNN section.

Note: You can only scan documents into WYNN Wizard.
Scanning a Page and Making a New Document

To scan a page and create a new document:

1. Place the page you want to scan facedown on your scanner. Refer to your scanner's manual for more information on how to begin scanning.

2. Click the Scan button on the blue File Management toolbar.

   WYNN scans the page, recognizes the text, and displays a new document containing the text of the page you scanned. This is known as Text View.

   **Note:** If you are scanning a page into an existing document, WYNN automatically appends the scanned page to the end of the current document. For more information about scanning pages into existing documents, see Scanning and Inserting a New Page or Scanning and Replacing the Current Page.

3. To see the original version of the page, click the Exact View button.

   To return to the text version, click the Text View button.
Scanning and Inserting a New Page

When scanning a page into an open WYNN document, WYNN automatically adds the scanned page to the end of the document.

To insert the new page in another part of the document, do the following:

1. Click the Open button on the blue File Management toolbar, and open the document that you want to add the new page to.

2. Move your cursor to the location where you want to insert the page.

**Important:**
The scanned page appears before the selected page. For example, if you want to insert the new page between pages 10 and 11, place your cursor on page 11 before scanning the page.

3. Place the page you want to scan facedown on your scanner. Refer to your scanner's manual for more information on page placement.

4. From the Scan menu, choose Scan and Insert New Page.

WYNN scans the page and recognizes the text. It also inserts the new page before the page where you placed the cursor.
Scanning and Replacing the Current Page

To replace a page in a WYNN document with a newly scanned page:

1. Click the Open button on the blue File Management toolbar, and open the document that you want to add the new page to.

2. Move your cursor to the page you want to replace.

3. Place the page you want to scan facedown on your scanner. Refer to your scanner’s manual for more information on page placement.

4. From the Scan menu, choose Scan and Replace Current Page.

5. WYNN scans the page and recognizes the text. WYNN deletes the page where your cursor is located and replaces it with the scanned page.

Reading a Document

WYNN can read a document or Web page aloud and “spotlight” the spoken words as you read along.

To read a document:
1. Open a document or Web page.

2. Select a starting point by clicking a word. The spotlight appears on that word.

   For example,

   ![Spotlight](image)

   Customize your reading preferences...

   **Tip:** To change the appearance of the Spotlight, go to the **Settings** menu and navigate to the **Visual Settings** tab.

3. Click the Read button.

   ![Read](image)

   WYNN reads the document aloud and moves the spotlight along as it reads. In addition, the Read button switches to the Pause button.

4. To stop reading, click the Pause button.

   ![Pause](image)

5. To start reading again from the current cursor position, click the Read button.

   ![Read](image)

   To change the way WYNN pronounces certain words, refer to the **Adding Words to the Pronunciation Dictionary** section.

   **Tip:** You can also press F2 or choose **Start Reading** from the **Tools** menu to start reading.
Switching Between Exact View and Text View

When you scan a document, the WYNN system creates two versions: an exact image view, and a text only view.

- The exact image view shows the document exactly as it appears in the original.
- The text only view extracts only the text from the scanned document. Text Only mode is the default view after scanning a document.

To switch between Exact View and the Text View:

1. Click the Exact View button to view the current document in its original form, which may be a scanned image, PDF file, Microsoft Word document, or any other supported file format.
For example:

In Exact View, you can read the text as it appears in its original format, or zoom-in to enlarge the entire image (using the View menu). If the document was scanned in Black and White, you can also change the background color.

When in Exact View, this button changes to the Text View button.

2. Click the Text View button only to see the text of the page, without formatting, graphics, line art, tables, and columns.
For example:

Flower Parts

Flowers are important in making seeds. Flowers can be made up of different parts, but there are some parts that are basic equipment. The main flower parts are the male part called the stamen and the female part called the pistil.

anther
filament
stamen

The stamen has two parts: **anthers** and **filaments**. The anthers

While in Text View, you can edit the text or use any of WYNN’s visual modifications from the green toolbar to change how the text appears.

Opening Multiple Voice Notes and Text Notes

You can insert Voice Notes and Text Notes throughout a document to provide key information, instructions, and questions about specific passages of text. You can also insert multiple Text and Voice Notes at the same location in a document. When this is done, the notes appear side-by-side in Text View mode.
However, in Exact View mode the notes appear as a single Text Note or Voice Note icon.

To determine if one or more notes appear at a particular location in a document while using Exact View mode, do the following:

1. Place your mouse pointer over a Text Note or Voice Note icon, and right-click on the icon. A popup menu appears.
If the **Edit Note (select)** command appears with a right arrow, this indicates the presence of multiple notes. If there is only a single note at that particular location, the right arrow does not appear.

2. Click the **Edit Note (select)** command to view, and select a specific note.

The Text Annotation or Voice Annotation dialog appears depending on the type of note selected.

3. Click **Stop** or **Cancel** to close the Voice Annotation dialog, or click **OK** to close the Text Annotation dialog.

4. Repeat steps 1-3 to open more notes.

For more information, refer to [Creating a Text Note](#) and [Leaving a Voice Note](#).
Changing the Speech Rate

You can increase or decrease WYNN’s rate of speech to a setting that is comfortable for you. There are two ways to do this by using either the Rate button on the green Reading Styles toolbar to quickly change the speech rate, or the Speech Settings command on the Settings menu for a more precise speech rate.

Using the Rate Button

To change the speech rate:

1. Click the Next button until the green Reading Styles toolbar appears.

2. Click the Rate button.

The Rate button has five speech rate settings. The settings may vary according to your speech synthesizer, but are usually:

- 130 words-per-minute (WPM)
- 160 WPM
- 190 WPM
- 220 WPM
- 250 WPM

3. Continue to select the Rate button until you are satisfied with the speech rate.
Using the Speech Settings Command

To select a more precise speech rate:

1. On the Settings menu, click Speech Settings.
   The Speech Settings property sheet appears.

2. Select the **Rate** slider and move it left or right to decrease or increase WYNN's speech speed. The speech rate appears in words-per-minute (WPM).

3. Click the **Test** button to listen to the new setting.

4. Repeat steps 2 and 3 until you are satisfied with the speech rate.

5. Click the **OK** button to accept the change, or click the **Cancel** button to restore the previous settings.
**Changing Line and Word Spacing**

To enhance readability when in text view, you can change the amount of spacing that appears between words and lines in a paragraph.

To increase line spacing:

1. Click the **Next** button until the green **Reading Styles** toolbar appears.

2. Click the **Line Space** button.

   ![Line Space](image)

   The spacing between lines of text increases.

3. If necessary, continue to click the **Line Space** button until you are comfortable with the spacing. You can cycle through six preset line space settings using this button.

   **Note:** Any changes made to these settings are automatically saved upon exiting the application. When you log in again, the last used settings are automatically loaded.

To increase word spacing:

1. From the green **Reading Styles** toolbar, click the **Word Space** button.

   ![Word Space](image)
The spacing between words increases. You can cycle through six preset word spacing settings.

2. If necessary, continue to click the **Word Space** button until you are comfortable with the spacing.

**Note:** Any changes made to these settings are automatically saved upon exiting the application. When you log in again, the last used settings are automatically loaded.

**Tip:** To make changes to the visual settings beyond what is offered on the green Reading Styles toolbar buttons, go to Settings, and then choose Visual Settings.

### Saving a Document

To save a document in WYNN:

1. From the blue **File Management** toolbar, click the **Save** button.

   ![Save](image)

   If the file is new, the **Select a file to Save to** dialog appears. Enter a file name and click **Save**.

   If a file with the same name already exists in the selected folder, WYNN asks you if you want to overwrite the existing file.

   Click the **OK** button to replace the existing file.

   Click the **Cancel** button if you do not want to overwrite the file.

   To save a new document, or to save an existing document with a new name:
1. From the blue **File Management** toolbar, click the **Save As** button.

The **Select a file to Save to** dialog box appears.

If you want to save the file in a different format, click the **Save As Type** combo box. This allows other programs, such as Microsoft Word, to read this file.

If you want to save the file in a different folder on your computer, locate and select the folder using the **Save In** combo box.

2. Enter a file name into the **File name** edit box, and click the **Save** button.
Changing WYNN’s Voice, Language, or Synthesizer Settings

WYNN supports RealSpeak Solo (SAPI 5) and ETI-Eloquence (SAPI 4) speech synthesizers. You may switch between synthesized voices at any time while using WYNN.

Note that during a typical full product installation, the following RealSpeak Solo (SAPI 5) voices are automatically installed from the WYNN program CD:

- US English Samantha
- US English Tom
- UK English Emily
- Mexican Spanish Paulina
- Canadian French Julie

The following RealSpeak voices are also available on the RealSpeak Voices CD, which is standard with the full WYNN 5.10 version.

- UK English Daniel
- Australian English Karen
Getting Started

- Australian English Lee
- Spanish Isabel
- Mexican Spanish Javier
- French Canadian Felix
- French Virginie
- French Sebastien
- German Steffi

**Changing Speech Settings**

To change WYNN's current voice, language, or synthesizer:

1. On the **Settings** menu, click **Speech Settings**.

   The **Speech Settings** property page appears.

2. Do one or more of the following:
<table>
<thead>
<tr>
<th>If you want to change...</th>
<th>Then</th>
</tr>
</thead>
</table>
| Only the voice           | Make a selection from the **Voice** list box.  
If the voice you want is not available in the Voice list box, first change the synthesizer value in the **Synthesizer** list box. For example, change SAPI 4 Voices (ETI-Eloquence) to SAPI 5 Voices (RealSpeak Solo). |
| The language and voice   | Choose a language from the **Language** list box, and a voice from the **Voice** list box.  
Remember that it may be necessary to change the synthesizer value if the voice you want does not appear in the list. |
| The synthesizer, language, and voice | Choose a synthesizer from the **Synthesizer** list box, a language from the **Language** list box, and a voice from the **Voice** list box. |

3. Click the **Test** button to listen to the new settings.

If necessary, make adjustments using the **Volume**, **Pitch**, **Rate**, and **Inflection** commands.

4. Click the **OK** button to accept the change, or click the **Cancel** button to restore your previous settings.

**Note:** Any changes made to the speech settings are automatically saved upon exit. When you log in again, your last used settings are automatically loaded.
Saving a Speech Profile

WYNN allows you to save your speech settings as a separate profile that can be easily loaded at a later date. For example, you can create and save a Spanish voice profile for those occasions when you encounter Spanish text.

The general steps to creating a voice profile are as follows:

- Make the appropriate voice, language, and synthesizer changes that appear on the Speech Settings property sheet.
- Save the new voice profile

The following describes how to save a voice profile.

1. On the **Settings** menu, click **Save Settings**.

   The **Save Settings** dialog appears.

2. Type a file name into the **Enter new settings file name** edit box. For example, My Spanish Voices.

3. Click the **More** button, and select the **Speech Settings** radio button.

4. Click the **Save** button, and then click **Yes** to confirm the change.
These settings become the current system settings and remain so until you restore or change and save settings again.

**Loading a Speech Profile**

To retrieve your Speech Settings file, do the following:

1. On the **Settings** menu, click **Retrieve Settings**.

   The **Retrieve Settings** dialog appears.

   ![Retrieve Settings dialog](image)

   - **Current settings file:**
     - default

   - **Choose a settings file to retrieve:**
     - **My Spanish Voices**
     - **No Speech**
     - **SAPI 4 Voices**
     - **SAPI 5 Voices**
     - **Default Toolbar Settings**

   - **Modified Date/Time**:
     - 08/18/06, 01:45 PM
     - 08/16/06, 02:47 PM

2. From the Name column, choose your saved file. Your previously saved file can easily be located by looking for the words Speech Settings in the Type column.

3. Click the **OK** button.
Getting to Know WYNN

This section provides a description of various parts of the WYNN screen, which includes:

- **The User Interface**
- **Toolbars**
- **Menu Bars**

**WYNN User Interface**

The table that follows the screen graphic explains the major parts of the WYNN screen.

This is the true story of the mutiny on board the ship called the Bounty. It is a story that has been told, told again, and told incorrectly. It is a story full of adventure, passion, and mystery. And best of all, it's true.

In 1787, the Bounty set sail from England to its eventual destination, Tahiti. Its mission was to collect sapling breadfruit trees and transport them to the West Indies, where the British planned to use them as a cheap source of food for the native workers.

To lead this mission, the Admiralty chose a gifted navigator who had just returned from sailing with Captain Cook to the Pacific. His name was William Bligh. This was the infamous Captain Bligh, portrayed in books and films as a cruel, sadistic, arbitrary taskmaster. The truth is as far from the myth as Tahiti is from the shores of England.
<table>
<thead>
<tr>
<th>User Interface Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>File Name. The file’s name appears in the WYNN title bar.</td>
</tr>
<tr>
<td>2</td>
<td>WYNN Menu Bar. All WYNN commands are available using these menus.</td>
</tr>
<tr>
<td>3</td>
<td>WYNN Toolbars. This row of buttons contains the common toolbar buttons and the current toolbar’s buttons. The primary toolbars are the blue File Management toolbar, the green Reading Styles toolbar, the pink Study Tools toolbar, and the yellow Writing Tools toolbar.</td>
</tr>
<tr>
<td>4</td>
<td>Spotlight Text. When in Read mode, the cursor position appears as spotlighted text.</td>
</tr>
<tr>
<td>5</td>
<td>Document Work Area. Your document appears in this scrollable area.</td>
</tr>
<tr>
<td>6</td>
<td>Cursor and Page Locator. Indicates which line the cursor is in, and it indicates which page is currently in view.</td>
</tr>
<tr>
<td>7</td>
<td>Read/Write and Text View/Exact View Indicator. Shows the document’s current editable (Read Only or Write) and viewable (Text View or Exact View) status.</td>
</tr>
<tr>
<td>8</td>
<td>User Name. Shows you who is currently logged in to the WYNN system.</td>
</tr>
</tbody>
</table>
WYNN Toolbars

WYNN's toolbars provide quick access to many different commands. There are four primary toolbars, each with different colors and buttons. In addition, there are several buttons available on each toolbar: the Next, Read/Pause, Write/Read-Only, Exact View/Text View, and Other Doc buttons. Each toolbar is briefly described in the following sections.

Tip: From the Settings menu, choose Custom Toolbar to create a customized toolbar with the commands you use most often. Refer to the topic Creating a Custom Toolbar for more information.

Common Toolbar Buttons

The Common Toolbar buttons always appear as the first five buttons from left to right on the WYNN screen. Use these buttons to:

- Switch from one toolbar to another
- Start or stop WYNN from reading aloud
- Edit a document
- View a document in its original formatted state or as text
- Open the NavBar and switch between open WYNN documents
The following table describes these buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Next" /></td>
<td>Click the <strong>Next</strong> button to cycle through WYNN's four color-coded toolbars. The color of the bar at the top of the button indicates which toolbar will display when you click the button. The color of the up arrow indicates the active toolbar.</td>
</tr>
<tr>
<td><img src="image" alt="Read" /> <img src="image" alt="Pause" /></td>
<td>When you click Read, WYNN reads the document aloud and moves the spotlight along as it reads. While WYNN is reading, this button changes into the Pause button. Click the <strong>Pause</strong> button to stop reading. Click <strong>Read</strong> again to resume reading from the current cursor position.</td>
</tr>
<tr>
<td><img src="image" alt="Write" /> <img src="image" alt="ReadOnly" /></td>
<td>Click Write if you want to edit or make additions to the text of the current document. This button is not available in Exact View, and changes you make in Text View are not visible in Exact View. When the document is in Write mode, this button changes into the Read Only button. Click the <strong>Read Only</strong> button to return to Read-only mode. You cannot write or edit text in Read-only mode.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Exact View" /> <img src="image2.png" alt="Text View" /></td>
<td>Click the <strong>Exact View</strong> button to see the current document in its original form, which may be a scanned image, PDF file, Microsoft Word document, or any other supported file format. While in Exact View, you can zoom (using the View menu), read text, and change text and background colors if the document was scanned in black and white mode. You cannot make any changes to the actual document text. When in Exact View, this button changes to the Text View button. Click the <strong>Text View</strong> button to see just the text of the page, without any formatting, including graphics, line art, tables, and columns that affect how the page appears. While in Text View, you can edit the text or make modifications to how the text looks using the green toolbar’s Visual settings buttons.</td>
</tr>
<tr>
<td><img src="image3.png" alt="File List" /></td>
<td>Click the <strong>File List</strong> button to open the left-hand navigation panel. You can then switch between your open documents. The maximum number of documents you can have open is determined in <a href="#">General Settings</a>. You can also use the Window menu to switch between open documents. Either select the document you want to switch to from the menu or choose <strong>Next Document</strong>.</td>
</tr>
</tbody>
</table>
**File Management Buttons**

Use the blue buttons on this toolbar to scan, create, open, close, print, and save documents. You can also use this toolbar to access WYNN’s document clean-up function and the Internet.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Scan" /></td>
<td>Place a page on your scanner and click the <strong>Scan</strong> button to begin scanning. WYNN scans the page, recognizes the text, and displays it in Text View. You can interrupt the scanning process by clicking the <strong>Cancel</strong> button. If you scan additional pages, WYNN inserts these new pages after the page the last page scanned. In order to scan a document directly into WYNN, you must use WYNN Wizard and have previously installed your scanner. You cannot scan documents if you are using WYNN Reader or have not installed a scanner. <strong>Tip:</strong> To change your scanning and OCR preferences, choose <strong>Scanning Settings</strong> from the <strong>Settings</strong> menu. To use a different scanner or driver, choose <strong>Scanner Selection</strong> from the <strong>Advanced</strong> menu.</td>
</tr>
</tbody>
</table>
### Button Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![New Button](image) | Click the **New** button to create a new WYNN document. You can type new text into this document or scan new pages into it.  
If you create a new document while the maximum number of documents is already open, WYNN asks you to save your changes to the document you have accessed the least recently and then closes it. To change the number of documents you can have open, choose **General Settings** from the File menu.  
**Tip:** You can also press **CTRL+N** to create a new document. |
| ![Open Button](image) | Click the **Open** button to open an existing file in WYNN. Locate the file on your computer and then click Open to load the file. If the file you want to open is not in the list, use the Look In combo box to select a different folder.  
You can open other types of files using either WYNN Wizard or WYNN Reader by making a new selection in the Files of Type combo box. WYNN can read Microsoft Word (.doc) files, text (.txt) files, HTML files, and rich text format (.rtf) files. WYNN Wizard can also open PDF files. When you open a PDF file in WYNN Wizard, it becomes available just as if you had scanned it in. When you open files of other types, WYNN displays the contents of these files in the Text View without any |
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>special formatting. To view these files in their original format, you should open them in the program they are normally associated with, and then print them to WYNN using the Freedom Import Printer driver. If you create a new document while the maximum number of documents is already open, WYNN asks you to save your changes to the document you have accessed the least recently and then closes it. To change the number of documents you can have open, choose <strong>General Settings</strong> from the File menu. <strong>Tip:</strong> You can also press <strong>CTRL+O</strong> to open a file.</td>
</tr>
<tr>
<td><img src="Image" alt="Close Button" /></td>
<td>Click the <strong>Close</strong> button to close the active document. If you have made any changes or added mark-ups to the document, WYNN asks you if you want to save them. Click <strong>Yes</strong> to keep your changes. Click <strong>No</strong> to discard your changes. WYNN automatically saves any additional pages you have scanned and added to the document. <strong>Tip:</strong> You can also press <strong>CTRL+W</strong> to close a document.</td>
</tr>
<tr>
<td><img src="Image" alt="Save Button" /></td>
<td>Click the <strong>Save</strong> button to save changes to your document. WYNN saves the document using the current file name and location.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="save.png" alt="Save As" /></td>
<td>Click the <strong>Save As</strong> button to save your document with a new file name and/or location. After you click this button, enter a new name for the file in the <strong>File Name</strong> edit box. You can save the file in a different format by making a new selection in the <strong>Save As Type</strong> combo box. This allows other programs, such as Microsoft Word, to read this file. If you want to save the file in a different folder on your computer, select the folder in the <strong>Save In</strong> combo box. Click <strong>Save</strong> to save your document using the new name and/or location. If a file with the same name already exists in the folder you selected, WYNN asks you if you want to overwrite the existing file. Click <strong>OK</strong> to replace the existing file. Click <strong>Cancel</strong> if you do not want to overwrite the file.</td>
</tr>
<tr>
<td><img src="print.png" alt="Print" /></td>
<td>Click the <strong>Print</strong> button (<strong>CTRL+P</strong>) to print the active document. Choose the printer you want to use to print the document. Then specify which parts of the document you want to print and the number of copies you want to create. Click <strong>OK</strong> to begin printing. You can choose to print only text that you have highlighted in the document by selecting the <strong>Highlight Text Only</strong> radio button. You can also choose to print only the content of all text notes in the document by selecting the <strong>Text Notes Only</strong> radio button. For more information on these features, refer to the help topics for the <strong>Highlight</strong> and <strong>Note</strong> toolbar buttons.</td>
</tr>
</tbody>
</table>
## Getting to Know WYNN

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Clean-up" /></td>
<td>The Clean-up feature (also known as Document Clean-up) corrects any scanning or OCR errors that occur during document scanning. When you click <strong>Clean-up</strong>, your scanned document appears in a split-screen view that shows text in the upper half and the scanned image in the lower half. <strong>Note:</strong> Click <strong>No Clean-up</strong>, and your screen returns to its previous whole-screen view (text or exact). For more information and procedures, see <a href="#">Document Clean-up</a>. <strong>Tip:</strong> You can also press <strong>SHIFT+F7</strong> to enter and exit Document Clean-up.</td>
</tr>
<tr>
<td><img src="image" alt="Go To Web" /></td>
<td>Click the <strong>Go To Web</strong> button to begin browsing the Internet. You can also open a new Web document. For more information on WYNN's Web features, refer to the help topic <a href="#">Browsing the Web</a>. For more information on configuring your Internet connection and changing your Web preferences, refer to the help topic <a href="#">Web Settings</a>.</td>
</tr>
</tbody>
</table>
Reading Styles Toolbar

Use the green buttons on this toolbar to change the way documents appear visually and audibly in WYNN. You can use this toolbar to change the text size, word and line spacing, page margins, text and background color combinations, speech rate, masking settings, reading mode, and the length of pauses between sentences.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Size" /></td>
<td>Click the <strong>Size</strong> button to increase the size of all text in the Text View of the document. You can cycle eight preset sizes through using this button. The smallest size is 10 points, while the largest size is 72 points. <strong>Tip:</strong> To specify an exact point size for the text, choose <strong>Visual Settings</strong> from the <strong>Settings</strong> menu. Adjust the <strong>Text Size</strong> slider bar until you find the desired text size and then click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
### Button Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Line Space](image) | Click the **Line Space** button to increase the amount of space between all lines of text in the Text View of the document. You can cycle six preset line spacing settings through using this button.  
**Tip:** To manually specify the amount of line spacing, choose **Visual Settings** from the **Settings** menu. Enter the amount of space you want between lines of text in the **Extra Spacing Between Lines** edit spin box and click **OK**. |
| ![Word Space](image) | Click the **Word Space** button to increase the amount of space between all words in the Text View of the document. You can cycle six preset word spacing settings through using this button.  
**Tip:** To manually specify the amount of word spacing, choose **Visual Settings** from the **Settings** menu. Enter the amount of space you want between words in the **Extra Spacing Between Words** edit spin box and click **OK**. |
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Margins button" /></td>
<td>Click the Margins button to increase the amount of blank space between the left and right edges of the page and the document text. You can cycle six preset margin settings using this button. Changes to the document margins are only visible in Text View. To manually specify margins or define different margins for the left and right side of the page, choose Visual Settings from the Settings menu. Enter the new left and right margins in the Side Margins area and click OK. <strong>Note:</strong> These margins are also used for the left and right print margins, but do not affect the top and bottom print margins specified in the Print Setup dialog box. If you select the Use Instead of Side Margin Settings check box in the Print Setup dialog box, you can enter new left and right margins that override those specified in the document.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| ![Color Button](image) | Click the Color button to cycle through preset combinations of text and background colors. These color combinations have been designed to make the page easier to read. The available color combinations are shown below:  
- Black text on a white background  
- Black text on a rose background  
- Black text on a beige background  
- Black text on a sky blue background  
- White text on a black background |

**Tip:** To create your own background and text color combination, choose **Visual Settings** from the **Settings** menu. Select a new text color and background color from the available choices and click **OK**.
Getting to Know WYNN

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mask Button" /></td>
<td>Click the Mask button to cycle through the different masking options. Masking is a special tool that shades certain elements of the document in order to emphasize the current line, sentence, or paragraph. You can only use masking in the Text View of a document. The four masking options are:</td>
</tr>
<tr>
<td></td>
<td>• No masking - No masking is applied to the document.</td>
</tr>
<tr>
<td></td>
<td>• Line masking - Shades all text except the line where the cursor is currently located.</td>
</tr>
<tr>
<td></td>
<td>• Sentence masking - Shades all text except the sentence where the cursor is currently located.</td>
</tr>
<tr>
<td></td>
<td>• Paragraph masking - Shades all text except the paragraph where the cursor is currently located.</td>
</tr>
</tbody>
</table>

**Tip:** To make the shaded background and text lighter or darker, choose Masking from the Settings menu.

**Note:** You can only change masking settings while in Read only mode. When in Edit mode, you can only see masked text when you press the Read button to read the document.
### Getting to Know WYNN

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Self-Pace button" /></td>
<td>The Self-Pace button allows you to control the pacing of WYNN's speech when reading documents. After you click Self-Pace, choose one of the following reading options:</td>
</tr>
</tbody>
</table>

- **Continuous** - When you click the Read button, the spotlight moves to emphasize the text WYNN speaks. WYNN continues reading the document until you click the Pause button.

- **By Line** - When you click the Read button, WYNN reads the line of text emphasized by the spotlight and then stops. Click the Read button again to read the next line.

- **By Sentence** - When you click the Read button, WYNN reads the sentence emphasized by the spotlight and then stops. Click the Read button again to read the next sentence.

- **By Paragraph** - When you click the Read button, WYNN reads the paragraph emphasized by the spotlight and then stops. Click the Read button again to read the next paragraph.

**Tip:** To manually adjust your reading preferences, choose **General Settings** from the Settings menu.
## Button Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Rate](rate_button.png) | Click the Rate button to increase number of words per minute (WPM) WYNN speaks when reading text. There are five preset speech rate settings that you can cycle through using this button: 130, 160, 190, 220, and 250 WPM.  
**Tip:** To manually change the speech rate, choose **Speech Settings** from the **Settings** menu. Use the **Rate** slider to determine how many words per minute WYNN speaks. |
| ![Pause](pause_button.png) | WYNN pauses slightly after each sentence just as a natural speaker would. You can use the Pause button to increase the length of this pause. There are four settings that you can cycle through using this button, allowing you to set the amount of pause from 0 to 1.5 seconds.  
**Tip:** To manually specify the length WYNN should pause between sentences, choose **Speech Settings** from the **Settings** menu and make a new selection in the **Extra Pause After Each Sentence** combo box. |
Study Tools Toolbar

The pink buttons on this toolbar allow you to access the basic and standard talking dictionaries, spell words audibly, divide words into syllables, highlight text, add bookmarks, view a list of highlighted or bookmarked words, and create text and voice notes.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Dictionary](image) | WYNN includes a talking dictionary that lets you look up definitions and synonyms for words in your document. Click a word and then click the **Dictionary** button to view the word's dictionary entry. When you click **Dictionary**, you can choose to look up the word using the Standard dictionary or the Basic dictionary. The Standard dictionary is 7th-8th grade level while the Basic dictionary is 5th grade level. 

The dictionary entry for the selected word. When you finish working with the dictionary, click **Close** to return to your document. |
## Button Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| Spell | WYNN can spell words that may be difficult to read.  

To spell a word out loud:

- Click the word and then click the **Spell** button.  

WYNN displays the word and its spelling. WYNN then reads the word, reads and highlights each letter, and reads the word again.  

To read and spell the word again:

- Click **Repeat**.  

To return to your document:

- Click **Close**.  

This button is not available if you have cleared the **Text** check box in the **Speak What?** area of the Speech Settings dialog box. |

| Syllables | You can use WYNN to divide words into individual syllables and display the word's phonetic spelling. To see the syllables and the phonetic spelling of a word, click the word and then click the **Syllables** button. You can click **Read Word** to if you want WYNN to speak the word aloud. Click **Read Syllables** to have WYNN read each individual syllable separately. Click **Close** when you are finished to return to your document. |
WYNN allows you to indicate important passages or key words in your document just as you would highlight text in a book.

To highlight text in your document:

- Click the **Highlight** button and choose a highlight color from the list. Your mouse pointer changes into a highlighter pen.
- Click and drag the highlighter pen over text you want to highlight. WYNN highlights the text using the color you selected. You can highlight a single word by clicking it.
- Click the **Highlight** button again when you are done highlighting text to return the cursor to normal.

To erase highlighting, click the **Highlight** button and then select the eraser at the bottom of the list. Your mouse pointer changes into a pencil eraser. Click and drag the eraser over the highlighting you want to remove. You can erase the highlighting for an individual word by clicking the word.

**Tip:** You can search for highlighted text using the **Find** toolbar button, or create a list of highlighted text with the **Lists** toolbar button. To print out just the text you highlighted in the document, click the **Print** button and select the **Highlight Text Only** radio button.
Getting to Know WYNN

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Lists" /></td>
<td>WYNN allows you to create a new document containing text you have highlighted or bookmarked. You can use this feature to make lists of topic sentences, vocabulary words, useful facts, and more.</td>
</tr>
</tbody>
</table>

To create a list, click the Lists button and choose the type of list you want to create and how you want to sort it:

- **By Highlight Color** - Creates a list of all highlighted words or phrases. Text highlighted in green appears first in the list, text highlighted blue appears second, and text highlighted in magenta appears last. This choice is useful for categorizing information.

- **By Highlight Order** - Creates a list of all highlighted words or phrases in the order they appear in the original document. This choice is useful for creating study guides with key points and supporting points.

- **By Bookmark Type** - Creates a list of all bookmarked words or phrases from the original document. WYNN sorts the text into groups separated by bookmark type.

- **By Bookmark Order** - Creates a list of all bookmarked words or phrases arranged in the order they appear in the original document.
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>After selecting, WYNN creates a new document containing the highlighted or bookmarked text. If you have more than the maximum number of documents open, WYNN asks you to save your changes to the document you have accessed the least recently and then closes it.</td>
</tr>
<tr>
<td><img src="image" alt="Bookmark" /></td>
<td>WYNN lets you bookmark important passages of text in a document for quick reference. When you choose a bookmark, a beginning and ending bookmark will appear around the word where the cursor is located. To bookmark a phrase, first select the text you wish to bookmark, then choose your bookmark from the Bookmark button. To erase a bookmark, click the <strong>Bookmark</strong> button and select the eraser at the bottom of the list. Your mouse pointer changes into a pencil eraser. Click and drag the eraser over the bookmarked text. <strong>Tip:</strong> You can search for bookmarks using the <strong>Find</strong> toolbar button, or create a list of bookmarked text with the <strong>Lists</strong> toolbar button.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Note" /></td>
<td>WYNN allows you to add notes to any location in your document. Teachers can create notes containing messages, questions, or assignments for students. Students can use notes to answer the teacher's questions, create reminders, or ask questions about the text. An icon appears where the note is located. To read the note, double-click the icon. To erase a note, put the cursor to the right of the Note icon and press the Backspace key on your keyboard. <strong>Tip:</strong> You can search for notes in the document by using the <strong>Find</strong> toolbar button. When you print your document, all your notes are printed on a separate page with the heading Text Notes. To print just the notes contained in your document, click the <strong>Print</strong> button and select the <strong>Text Notes Only</strong> radio button.</td>
</tr>
</tbody>
</table>
Voice Notes are useful for those with stronger auditory than visual processing skills. This feature allows you to use the microphone to record a spoken message. Teachers can create Voice Notes containing questions, messages, or assignments for students. Students can use Voice Notes to record answers to the teacher’s questions, create reminders, summarize or paraphrase, or ask questions about the text. An icon appears where the Voice Note is located. To listen to the note, double-click the icon. To erase a note, put the cursor to the right of the Note icon and press the Backspace key on your keyboard.

**Tip:** You can search for Voice Notes in the document by using the **Find** toolbar button.

### Writing Tools Toolbar

Use the yellow buttons on this toolbar to cut and paste text, apply bold, italic, and underline to text, find text in the document, create and work with an outline, enable/disable Word Prediction, check for homophones, and check your spelling.
### Getting to Know WYNN

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Cut/Paste](image) | **The Cut/Paste** button allows you to cut, copy, and paste text. You must enter Write mode using the **Write** toolbar button before you can cut or paste text.  
**Tip:** You can also press **CTRL+C** to copy, **CTRL+X** to cut, and **CTRL+V** to paste, or you can choose these options from the **Edit** menu.  
**Tip:** You can paste text from WYNN into other applications, such as Microsoft Word. You can also paste text from other applications into WYNN. Use the copy, cut, and paste commands in the other applications just as you would use them in WYNN. These commands usually appear on the application's **Edit** menu. |
| ![Style](image) | **The Style** button allows you to apply bold, italics, or underline to text in your document. While in Write mode, click to place your insertion point within a word or select a range of text. Click the Style button and choose Bold, Italic, or Underline. WYNN then applies the formatting to the word or selected text.  
**Tip:** Standard Windows commands will also work for these functions: **CTRL+B** to choose Bold, **CTRL+I** to add italics, and **CTRL+U** to underline text. |
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Find" /></td>
<td>Use the Find button to search for text or mark-ups in the active document. If you search for text, you can replace it with new text, if necessary. When you click the Find button, you can choose between two options. Choose <strong>Text</strong> to search for words and phrases. Choose <strong>Mark-Up</strong> to search for highlighting, bookmarks, text notes, and voice notes.</td>
</tr>
<tr>
<td><img src="image" alt="Go To" /></td>
<td>Click the Go To button to move to a specific page in your document. When you click Go To, a dialog box displays. Enter the page number of the page you want to move to and click the Go button. If you only want to move forward or back one page in the document, use the Next Page and Previous Page buttons. <strong>Tip:</strong> You can also press <strong>CTRL+G</strong> or choose Go To Page from the Edit menu to perform this command.</td>
</tr>
<tr>
<td><img src="image" alt="Outlines" /></td>
<td>Outlines can help you organize the topics and supporting points of your documents. You can use outlines to plan the organization of research papers, summarize study materials, create plots for stories, and more.</td>
</tr>
</tbody>
</table>
### Button Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Adjust" /></td>
<td>Use the Adjust button to make adjustments to an outline you created using the Outlines toolbar button. This button is only available when you are creating an outline. Move your cursor to a line in your outline and click the Adjust button. After you click Adjust, choose one of the following options:</td>
</tr>
</tbody>
</table>

- **Move Backward** - Increases the outline level of the line and all its sub-items.

- **Move Forward** - Decreases the outline level of the line and all its sub-items.

- **Move Up** - Moves the line and all its sub-items up by one-step within the current outline level.

- **Move Down** - Moves the line and all its sub-items down by one-step within the current outline level.

Refer to the help topic [Outlines](#) for more information on outline levels and creating outlines in WYNN. If you need additional assistance with outlines, refer to the Outline Tutorial.

**Tip:** You can also use the following shortcut keys to adjust the outline: move forward (TAB), move backward (SHIFT+TAB), move up (ALT+UP ARROW), and move down (ALT+ DOWN ARROW).
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Predict" /></td>
<td>Click the Predict button to activate WYNN's Word Prediction feature. Word prediction helps you write by making spelling suggestions and anticipating the next word you are going to type. This feature can help you with spelling, grammar, and formulating sentences.</td>
</tr>
<tr>
<td><img src="image" alt="Speak List" /></td>
<td>When Word Prediction is active, click the Speak List button to have WYNN read the list of suggested words. This button is unavailable if you are not using Word Prediction. For more information on the Word Prediction feature, refer to the help topic Predict.</td>
</tr>
<tr>
<td><img src="image" alt="Homophone" /></td>
<td>A homophone is two or more words that are pronounced alike, but have different meanings and often-different spellings.</td>
</tr>
</tbody>
</table>
| ![Spell Check](image) | Click the Spell Check button to check your document for spelling errors. If WYNN finds any misspelled words, a dialog box appears that allows you to correct the mistake. 

**Tip:** F7 also starts the Spell Check process. |
Web Toolbar

The Web toolbar only displays when you are browsing the Web in WYNN. To display the Web toolbar, click the Go To Web button on the File Management toolbar. The following describes each button on this toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Back" /></td>
<td>Click the <strong>Back</strong> button to return to pages you have previously visited during the current session.</td>
</tr>
<tr>
<td><img src="image" alt="Forward" /></td>
<td>Click the <strong>Forward</strong> button to move forward through pages you have already visited during the current session. You can only use this button if you have already clicked the Back button.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Click the <strong>Stop</strong> button to stop the current page from loading completely. This button is useful if a particular Web page is taking a long time to load or if you accidentally open the wrong page.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Click the <strong>Refresh</strong> button to reload the current page. Some pages may need to be refreshed in order to display recent updates. Refreshing may also help correct errors if a page does not display properly.</td>
</tr>
<tr>
<td><img src="image" alt="Home" /></td>
<td>Click the <strong>Home</strong> button to return to your home page.</td>
</tr>
<tr>
<td><strong>Button</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Click the <strong>Search</strong> button to search the Web for a particular subject or topic. Enter the topic you want to search for and then click the Search Now button. WYNN submits your search to <a href="http://google.com">Google.com</a> and then displays the results on your screen.</td>
</tr>
<tr>
<td><img src="image" alt="Favorites" /></td>
<td>Click <strong>Favorites</strong> to add a Web page to your list of favorites, organize your favorites, or visit pages in your favorites list.</td>
</tr>
<tr>
<td><img src="image" alt="History" /></td>
<td>Click the <strong>History</strong> button to see a list of Web pages you have visited in the past. Choose the day you want to view history for. All the Web sites that you visited are displayed in the left-side panel. Click a Web site to display a list of all pages on the Web site that you visited. Click a Web page name to open the page.</td>
</tr>
<tr>
<td><img src="image" alt="WebMask" /></td>
<td>Click the <strong>WebMask</strong> button to enable or disable the WebMasking feature. WebMasking shades distracting images and reduces visual clutter so you can focus on a specific element of the Web page, such as a paragraph or link. You can focus on a page element by clicking near it.</td>
</tr>
</tbody>
</table>
### Getting to Know WYNN

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Dictionary" /></td>
<td>Click a word and then click the <strong>Dictionary</strong> button to view the word's dictionary entry. When you click <strong>Dictionary</strong>, you can choose to look up the word using the Standard dictionary or the Basic dictionary. The Standard dictionary is 7th-8th grade level while the Basic dictionary is 5th grade level. The dictionary entry for the selected word displays. When you finish working with the dictionary, click <strong>Close</strong> to return to the Web page.</td>
</tr>
</tbody>
</table>
| ![Highlight](image2.png) | To highlight text in your document:  
  - Click the **Highlight** button and choose a highlight color from the list. Your mouse pointer changes into a highlighter pen.  
  - Click and drag the highlighter pen over text you want to highlight. WYNN highlights the text using the color you selected. You can highlight a single word by clicking it.  
  - Click the **Highlight** button again when you are done highlighting text to return the cursor to normal.  
To erase highlighting, click the **Highlight** button and then select the eraser at the bottom of the list. Your mouse pointer changes into a pencil eraser. Click and drag the eraser over the highlighting you want to remove. You can erase the highlighting for an individual word by clicking the word. |
WYNN allows you to create a new document containing text you have highlighted or selected on Web pages. You can use this feature to make lists of topic sentences, vocabulary words, useful facts, and more.

To extract Web text, click the Extract button and choose how you want highlights ordered or what you want to extract:

- **By Highlight Color** - Creates a list of all highlighted words or phrases. Text highlighted in green appears first in the list, text highlighted blue appears second, and text highlighted in magenta appears last. This choice is useful for categorizing information.

- **By Highlight Order** - Creates a list of all highlighted words or phrases in the order they appear in the original document. This choice is useful for creating study guides with key points and supporting points.

- **All Text** - Extracts all text on the Web page to a document. You can extract the text into a new document or append it to an existing document.

- **Selected Text** – Extracts selected text on the Web page to a document. You can extract the text into a new document or append it to an existing document.

After selecting, WYNN creates a new document containing the highlighted or bookmarked text. If you have more than the maximum number of
documents open, WYNN asks you to save your changes to the document you have accessed the least recently and then closes it.

Click the **File List** button to open the left-hand navigation panel. You can then switch between your open documents.

You can also use the Window menu to switch between open documents. Either select the document you want to switch to from the menu or choose **Next Document**.

Click the **Close Page** button when you are finished browsing the Web. WYNN closes the current Web page and displays the last document you were working on.

### WYNN Menu Bars

The menu bar allows you to access every function and command in WYNN. The menu bar contains ten menus. The following table describes each menu.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File List</strong></td>
<td>Click the <strong>File List</strong> button to open the left-hand navigation panel. You can then switch between your open documents. You can also use the Window menu to switch between open documents. Either select the document you want to switch to from the menu or choose <strong>Next Document</strong>.</td>
</tr>
<tr>
<td><strong>Close Page</strong></td>
<td>Click the <strong>Close Page</strong> button when you are finished browsing the Web. WYNN closes the current Web page and displays the last document you were working on.</td>
</tr>
</tbody>
</table>

**Tip:** If you wish to have the items on the menus speak, go to the **Settings** menu, then **Speech Settings**. From the **Speak What** option, check **Menus and Dialogs**.
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>The <strong>File</strong> menu allows you to manage files, print documents, view document properties, and more.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>The <strong>Edit</strong> menu allows you to switch between read-only and edit modes, cut/copy/paste and select text, apply character formatting, find/replace text and mark-ups, create outlines, and work with page numbering and order.</td>
</tr>
<tr>
<td><strong>Scan</strong></td>
<td>The <strong>Scan</strong> menu allows you to scan documents, change scanning speed, and control some basic scanning settings.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Use the <strong>View</strong> menu to show or hide certain elements of the WYNN application. You can also use this menu to switch to and magnify the Exact View for scanned documents.</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td>The <strong>Tools</strong> menu contains reading commands, study tools like a spell checker, dictionary/thesaurus, and homophone checker, and mark-up tools like highlighting and bookmarks.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Advanced</td>
<td>The <strong>Advanced</strong> menu allows you to access a number of special commands and features like Teacher Lockout, the Pronunciation Dictionary, and Word Prediction controls. You can also use this menu to launch external applications and select a scanner.</td>
</tr>
<tr>
<td>Settings</td>
<td>The commands available in the <strong>Settings</strong> menu allow you to customize WYNN. You can change visual settings, speech preferences, Web settings, masking, word prediction, differential coloring, and more. You can also customize WYNN’s toolbars.</td>
</tr>
<tr>
<td>Web</td>
<td>The <strong>Web</strong> menu provides access to commands you can use to browse the Internet. These commands are similar to those found in popular Internet browser software and include Web navigation, favorites, history, and a refresh command.</td>
</tr>
<tr>
<td>Windows</td>
<td>The <strong>Windows</strong> menu allows you to switch between documents currently open in WYNN.</td>
</tr>
<tr>
<td>Help</td>
<td>The <strong>Help</strong> menu lets you view WYNN’s online help system.</td>
</tr>
</tbody>
</table>
Teacher Exercise Guide

This section describes tasks that teachers can use to configure WYNN for overall operation. It also provides exercises that teachers can create or demonstrate for students.

Scanning with WYNN

The following links describe what you should know before scanning a document as described in the Scanning a Document into WYNN section.

- Before You Scan
- Color Scanning
- Scanning Multiple Pages
- Scanning Text without Charts or Tables
- Scanning Tables
- Scanning Difficult Text

Before You Scan

Before you scan a document, make sure that:

- You are using WYNN Wizard. WYNN Reader does not have scanning capability.
- Your scanner is turned on and connected to your computer.
- The drivers for your scanner are installed on your computer.
- WYNN is running.
- The blue File Management toolbar is active.
Important:

Always use the blue Scan button – [Image] – when scanning with WYNN. The Scan button appears on the blue File Management toolbar. If there is a Scan button located on your scanner, do not use this button to Scan documents into WYNN, even if instructed to do so in your scanner’s manual.

If your scanner has a Scan button, never use it when scanning with WYNN.

Note: Some scanners use the back of the scanner glass for page placement for the top of the page. Others use the front of the scanner glass. Each scanner has an arrow or some other mark to show you where the top of the page should be; make sure you are familiar with your scanner’s orientation.

Color Scanning

WYNN scans in color by default; however, color scanning takes longer than black and white scanning.

To enable black and white scanning:

- From the Scan menu, click the Color Scanning command.

  The checkmark no longer appears next to the command. All future scans use the black and white mode until you change this setting.

To re-enable color scanning:

- From the Scan menu, click the Color Scanning command.

  A checkmark no longer appears next to the command.
Scanning Multiple Pages

There are three parts to the scanning process: scanning the page image, processing the image, and recognizing the image, or converting it to electronic text. WYNN normally scans a page, then immediately processes and recognizes it before moving on to the next page. When scanning a document with multiple pages, Batch Scanning allows you to separate these processes; all the scanning is done at one time, followed by the processing and recognition of the pages. The WYNN program can scan multiple pages using the following scanning modes:

- Large Batch Scanning
- Express Batch Scanning
- 2-Page Scanning

Large Batch Scanning

Use Large Batch scanning mode to scan a large group of pages, such as a book, quickly and efficiently. This type of scanning requires your participation to turn the pages, but processing and recognition—the lengthier tasks—are done by your computer in a batch without your active participation.

To enable large batch scanning:

1. From the Settings menu, select the Scanning Settings command.

   The Scanning Settings property page appears.
2. From the **Scanning Mode** list box, select **Large Batch**.

3. Click **OK**.

WYNN is now configured for large batch scanning mode.

**Scanning in Large Batch Mode**

1. During scanning, the Batch dialog box appears after a page is scanned.
2. Select one of the following large batch options:

<table>
<thead>
<tr>
<th>If…</th>
<th>Then click</th>
</tr>
</thead>
<tbody>
<tr>
<td>You want to scan another page</td>
<td>Scan Another Page</td>
</tr>
<tr>
<td>You are finished</td>
<td>Done scanning</td>
</tr>
<tr>
<td>You want to pause scanning</td>
<td>Suspend scanning</td>
</tr>
<tr>
<td>You want to cancel scanning</td>
<td>Cancel Scanning</td>
</tr>
</tbody>
</table>

3. When scanning is complete, WYNN starts the processing and recognition tasks. The newly scanned pages appear in the open document.

**Note:** Any changes made to your scanning settings are automatically saved upon exit.

**Express Batch Scanning**

Express Batch scanning is an even faster way to scan multiple pages, but it also requires that you react quickly. This scanning mode skips the page-turning prompts, and requires that you follow the scanning process so that you know when to turn the page for the next scan.

To enable express batch scanning:

1. From the **Settings** menu, select the **Scanning Settings** command. The **Scanning Settings** property page appears.
With Express Batch Scanning enabled, as soon as the scanner head returns to its starting position, it starts scanning again. To set an additional delay, from the Express Batch Delay list box, select a value from 1 to 25 seconds as the delay that occurs between scanned pages. Otherwise, as soon as the scanner head returns to its starting position, it starts scanning again.

2. From the Scanning Mode list box, select Express Batch.

3. Click OK. WYNN is now configured for express batch scanning mode.

Note: Any changes made in your Scanning Settings property page are automatically saved upon exit.
To Scan in **Express Batch Mode**:

**Note:** If you are using an HP ScanJet 5500 series scanner, make the following adjustments in WYNN before scanning. Otherwise, you may experience problems when scanning in Express Batch mode.

From the **Advanced** menu, select the **Scanner Selection** command.

In the **Scanner Selection** dialog, select the **HP ScanJet 5500C** as your scanner, choose the three **TWAIN Properties** settings, and then click **OK**.

During scanning, you must watch and listen for when the scanner head reaches the bottom of the glass and returns to the top. In those few seconds, you must turn the page.

1. After scanning all the pages in the batch, press the **Cancel Scan** button.

The Batch scan dialog box appears.
2. Choose Done scanning.

When scanning is complete, WYNN starts the processing and recognition tasks. The newly scanned pages appear in the open document.

2-Page Scanning

WYNN’s 2-Page scanning mode is intended for physically smaller documents, such as paperback books, in which both pages of the open book fit on the scanner at the same time. With 2-page scanning enabled, the scanner sees these as one page, but WYNN processes them as two separate pages.
To enable two-page scanning:

1. From the Scan menu, click the 2-page Scanning command.

A checkmark appears next to the command. All future scans made during this session use the lengthy color-scanning mode until it is turned off.

To disable two-page scanning:

1. From the Scan menu, click the 2-page Scanning command.

A checkmark no longer appears next to the command.

**Scanning Text without Charts or Pictures**

You can expedite the scanning process by configuring WYNN to discard the Exact View of the pages. However, WYNN’s Document Clean-up function requires that the Exact View be able to compare the original image with the recognized text. This can be of great benefit in cleaning up documents that may have made errors during the recognition process. See Correcting Text in a Scanned Document for more information about this feature.
To do this:

1. From the **Settings** menu, select the **Scanning Settings** command.

   The **Scanning Settings** property page appears.

   ![Screenshot of Scanning Settings property page]

2. Uncheck the **Keep Exact View** command.

3. Click **OK**.

**Scanning Tables**

By default, WYNN automatically determines where the columns are on each page, then displays the columns in Text View in the proper order. However, when you scan a table, you do not want pages treated as though they have columns. You want WYNN to read all the way across the first line of the table, then the second line, and so on.

To do this, turn off WYNN’s **Recognize Columns** setting when scanning tables.
1. From the **Settings** menu, select the **Scanning Settings** command.

The **Scanning Settings** property page appears.

![Scanning Settings Property Page](image)

2. Uncheck the **Recognize Columns** command.

3. Click the **OK** button.

**Scanning Difficult Text**

When scanning difficult text, such as very small text, unusual fonts, or unusual layouts, use WYNN’s Most Accurate Scanning mode.

**Note:** This method of scanning may take longer than WYNN’s default settings.
To enable Most Accurate Scanning mode:

1. From the **Scan** menu, click the **Most Accurate Scanning** command.

A checkmark appears next to the command.

<table>
<thead>
<tr>
<th>Scan</th>
<th>View</th>
<th>Tools</th>
<th>Advanced</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Page</td>
<td>F3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan and Replace Current Page</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan and Insert New Page</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✓ Recognize Columns</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Scanning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2-page Scanning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✓ Most Accurate Scanning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fastest Scanning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To disable accurate scanning mode:

1. From the **Scan** menu, click the **Most Accurate Scanning** command.

A checkmark no longer appears next to the command.

**Rearranging Text in a Scanned Document**

Dynamic Zoning allows you to define your own reading order on a scanned page. Dynamic Zoning can also be used to avoid recognition errors from graphics, or to exclude the speaking of headers, footers, or other unwanted text.

**Note:** Use the Dynamic Zoning feature before using the [Document Clean-up](#) feature.

1. From the Advanced menu, choose Dynamic Zoning, and then Enable Dynamic Zoning.

The scanned image appears in Exact View mode with all current reading zones outlined in blue.
Take a moment to study the document and determine how you want to redefine reading zones.

2. Select the **Re-Define** button to remove the current zone indicators so that you can redraw the zones in the correct order.

3. Use your mouse to draw a box around each block of text you wish to have spoken. A red outline appears around redefined zones.
The reading order is determined by the order in which you define the zones. Do not draw zones around pictures or other graphic images that cannot be spoken.

**Note:** If you make a mistake while redefining zones, click the **Revert** button to return to the original zones on that page. You may also use **Erase** to erase all zones created and start over again.

4. To continue changing zones on other pages of the scanned document, press the **Page Down** key until the next page appears. (The message “Loading Page” appears in the lower left corner.) Again, the existing zones appear in blue.
5. Repeat step 2 and 3 to redefine the reading order for the next page. Repeat this process for each page you wish to re-zone.

6. After defining new zones on all pages that apply, select the Re-Process button. This tells WYNN to refresh the document using the newly defined zoning order.

Correcting Text in a Scanned Document

Use the Document Clean-up feature to correct any scanning or recognition errors that occurred during document scanning. This feature displays both the Exact View and the Text View of the document so you can compare them. This allows you to easily correct errors so that the text is spoken correctly in either view.

To correct the text of a scanned document:

1. From the Advanced menu, choose Document Clean-up.

   WYNN displays the Text View of the document in the top half of the window, and the Exact View of the document in the bottom half of the window.
2. Scroll through the Text View, and look for OCR errors.

3. Click an incorrect word you find in the Text View.

   WYNN moves your insertion point to the word. A pink rectangle appears around the word in the Text View window, while the same word appears as highlighted text in the Exact View window.

   **Note:** You can also click a word in the Exact View to place a pink rectangle around the location where the word appears in the Text View.

4. Correct any spelling or scanning errors.
Important:
When correcting errors, do not delete the whole word. First, type in the corrections, and then delete the errors. Deleting the entire word prior to inserting corrections erases the link that WYNN uses to connect the word in the Text View and Exact View. In this case, WYNN no longer spotlights the word in Exact View when reading.

5. Continue searching the Text View window for OCR errors. When you are finished, choose Document Clean-up from the Advanced menu.

6. Click the Save button from the blue File Management toolbar to save your corrections.

Document Clean-up Guidelines

Keep the following items in mind when using the Document Clean-up feature.

1. Use Exact View to reference original text.


3. Keep the link between Text View and Exact View by correcting parts of a word at a time until the entire word is corrected. If you delete an entire word in Text View, it breaks the link between Text View and Exact View. The location in Exact View is no longer spotlighted.

4. After closing the Document Clean-up feature, run Spell Check, in Text View mode, to catch random characters or mistaken words.

Guidelines for Increased Scanning Accuracy

- Use OCR Correction (Advanced menu) to catch repeated recognition errors.
• Modify Scanning Contrast (Settings menu, Scanning Settings command) for light text or dark paper.

• Use Dynamic Zoning to eliminate recognition of changes or graphics.

Scanning and Reading Other Languages in WYNN

WYNN can scan and read in several languages in addition to English. The ability to correctly scan text in other languages is automatically set during the installation process.

The speech synthesizers included with WYNN have the capability to pronounce text in U.S. English, Spanish, French, Italian, Brazilian, German, and British English. Using the “Typical” install, WYNN automatically installs U.S. English and Spanish as choices, with U.S. English as the default.

To install any of the other languages, choose “Custom” install. You may also choose to add any, or all, of the other languages after the initial installation has been complete by re-inserting the program CD and following the prompts.
Scanning Documents in a Language other than U.S. English

To change scanning language settings:

1. On the **Settings** menu, click the **Scanning Settings** command.

   ![Settings menu]

   The **Scanning Settings** property page appears.

2. Change the **Recognition Language** command to match the language of the document you are scanning.
This configures WYNN to correctly recognize any special characters of that language.

### Reading Documents in a Language other than U.S. English:

To change speech language settings, refer to the **Changing WYNN’s Voice or Language Settings** section.

**Tip:** When you exit WYNN, your current scanning and speech settings become your default settings, which are used next time you log in.

### Selecting the Correct Word Using Homophones

Being able to identify which word to use in a sentence can build a student’s vocabulary. The following task provides an overview for using the Homophones function for a student exercise.
1. Create or provide a passage of text that contains homophones.

You can do this by scanning text directly into WYNN, or by providing an external document (such as a Word, PDF, text, RTF, or HTML file) that WYNN can open.

2. Ask the student to open the document, and run the Homophones function using the Homophones button on the yellow **Writing Tools** toolbar.

3. Make sure that the student reads each definition and selects the correct word as used in the sentence.

**Broadcasting Documents and Settings**

Broadcasting is a powerful function that allows teachers to broadcast WYNN files and settings to a classroom of users. You can log on to a single computer and download files and settings for just the user accounts on a specific computer, or, if using the network version of WYNN, you can broadcast files and settings to all users on the network, regardless of which computer they use to log in.

**Note:** To broadcast documents or settings, you must sign in to WYNN using the login name Shared. This name does not appear on the list of user names, so you must manually enter it each time. The Broadcast Documents and Broadcast Settings commands are not available unless you log in with the name Shared.
Broadcasting Documents to Other Users

You can send documents to other WYNN users. This allows you to copy documents located in the Docs folder for the login name Shared to the Docs folder that belongs to each user.

To broadcast documents to other users:

1. If you are not already logged in as Shared, from the File menu, choose Log In Different User.

2. Sign in using the login name Shared and click OK.

3. From the Advanced menu, choose Broadcast Documents.
4. Select the document you want to broadcast. Hold down CTRL and click to select multiple documents. You can only broadcast documents stored in WYNN’s Shared\Docs folder.

**Note:** You can only broadcast closed documents. If the document is open, you must close it first before you can broadcast it.

![Broadcast Documents](image)

5. Click **Broadcast** to send the documents to all other users.
Broadcasting Settings to Other Users

WYNN allows you to send your abbreviation definitions, OCR corrections, personal spell check dictionary, pronunciation dictionary, word prediction lists, custom toolbars, and so on to all other users.

To broadcast customized or modified settings to other users:

1. If you are not already logged in as Shared, from the File menu, choose Log In Different User.

2. Sign in using the login name Shared and click OK.
3. From the Advanced menu, choose Broadcast Settings.

4. Select the type of settings you want to broadcast. Hold down CTRL and click to select multiple types of settings. You can only broadcast settings associated with the user name Shared.
5. Click **Broadcast** to send the settings to all other users.

Adding Words to the Pronunciation Dictionary

The Pronunciation Dictionary allows you to define how WYNN pronounces words that it reads aloud. Speech synthesizers do a good job of pronouncing words through a combination of text-to-speech programming and internal dictionaries. However, there may be some words that the synthesizer does not pronounce properly. These words vary from synthesizer to synthesizer. Using WYNN's Pronunciation Dictionary, you can change the pronunciation of any word.
To add a new word, phrase, or acronym to the Wynn pronunciation dictionary:


2. Scroll through the **Word List** to make sure that the new text does not appear in the pronunciation dictionary.

3. Type the new word into the **Word** edit box.

4. Enter a pronunciation for the word in the **Pronunciation** edit box.

Try spelling the word phonetically using simple combinations of consonants and vowels. Use spaces to separate letters if you want WYNN to say the name of the letter rather than make the associated sound (this is useful for acronyms).

**Tip:** You can also use spaces to isolate phonetic sounds created by two or more letters. The synthesizer clearly pronounces these sounds when reading the word.
5. Click **Test** to hear the new pronunciation of the word. Continue adjusting the pronunciation until you achieve the desired pronunciation.

6. When you are satisfied with the pronunciation, click the **Add** button to update the Pronunciation Dictionary.

7. Click **Close** to return to the active document.

## Configuring Word Prediction

The Word Prediction feature is useful for people who have difficulty coming up with words or spelling while writing. It offers suggestions that complete the word the student is typing, and it proposes the next word for the student to type. This allows your students to focus on getting their ideas “on paper,” regardless of their ability to spell.
Using the control tabs of WYNN’s Word Prediction Teacher Controls, you can:

- Customize word and phrase suggestions provided by the Word Prediction feature
- Increase or decrease the Word Prediction’s word list by adding words and phrases
- Define phonetic spelling information
- Choose writing styles, and more

**Word Prediction Learning Text Tab**

Use the **Word Prediction Learning Text** tab to have the word prediction system learn new words from a file or the current document. You can also have WYNN learn words as you type.

To analyze and learn vocabulary patterns from a plain text file or the current document:

1. From the Advanced menu, choose Word Prediction Teacher Controls.
2. Click the Word Predication Learning Text tab.

![Teacher Controls]

3. Do one of the following:
   - If you want WYNN to learn from the current document, click the **Current Document** button.
   
   …OR…
   
   - If you want WYNN to learn vocabulary patterns from a plain text file, click the **TextFile** button. Locate the file, select it, and click **Open**.

4. WYNN adds new phrases from the current document or text file to the word prediction list.

To analyze and learn vocabulary patterns as you type:

1. From the **Advanced** menu, choose Word Prediction Teacher Controls.

2. Click the Word Predication Learning Text tab.
3. Select the Automatically Learn as I Type check box.

4. If you want WYNN to check the spelling of each word or phrase before adding it to the word prediction list, select the **Spell Check Each Word Before Learning** check box.

5. Click **OK**.

**Word Prediction Edit List Tab**

As you type, new words and phrases are added to the word prediction list.

The **Word Prediction Edit List** tab allows you to select a different size word list or add words to the list for the current user.

---

**Tip:** You can search for words already in the word prediction list. To do this, enter the word and then click **Search**. WYNN displays a list of phrases containing the word.
Adding Words/Phrases to the List

To add a word or phrase to the word prediction list:

1. From the Advanced menu, choose Word Prediction Teacher Controls.
2. Click the Word Prediction Edit List tab.
3. Click the Add a Word button.
4. Type the word you want to add to the word prediction list.
5. Specify whether the word is a verb, noun, or other by selecting the corresponding radio button.

   WYNN automatically displays some suggestions based on the spelling of the word and the word's part of speech.

   - For verbs, WYNN suggests how the word appears when used in the various tenses.
   - For nouns, WYNN suggests how the word is pluralized and how it is used in different situations.
   - For other words, WYNN wants you to enter several phrases where the word is used in context.

   Review the suggestions and correct any words that do not reflect proper usage.

6. Click the OK button to add the word.

Restoring the Default List

To remove all changes made to your personal word prediction list and to restore the default list:

1. From the Advanced menu, choose Word Prediction Teacher Controls.
2. Click the Word Prediction Edit List tab.

3. Click the Clear All Personal Learned Text button.

4. Click OK to restore the default word list.

5. Click Cancel to keep your personalized word list.

Word Prediction Phonetics

Use the Word Prediction Phonetics tab to add, modify, or delete phonetic associations. This feature allows you to customize Word Prediction so that it corrects commonly misspelled phonetic sounds. For example, phonetic associations allow WYNN to recognize f as a possible misspelling of the sound created by the letters ph.

Adding Phonetic Associations

To add a new phonetic association to the word prediction list:
1. From the Advanced menu, choose Word Prediction Teacher Controls.

2. Click the Word Prediction Phonetics tab.

3. In the **Phonetic** edit box, type the incorrect phonetic spelling of the sound.

4. Type a comma.

5. Type the correct spelling of the sound.

   Example: To recognize f as a possible misspelling of the sound created by the letters ph, type "f,ph" in the Phonetic edit box. This creates a phonetic association between f and ph.

6. Click the **Add** button.

7. Click the **OK** button to save your changes.

**Modifying Phonetic Associations**

To modify an existing phonetic association:

1. From the Advanced menu, choose Word Prediction Teacher Controls.

2. Click the Word Prediction Phonetics tab.

3. Select the phonetic association you want to modify in the **List of Phonetic Associations**.

4. In the **Phonetic** edit box, change the phonetic association.

5. Click the **Update** button.

6. Click the **OK** button to save your changes.
Deleting Phonetic Associations

To delete phonetic associations:

1. From the Advanced menu, choose Word Prediction Teacher Controls.

2. Click the Word Prediction Phonetics tab.

3. Locate the phonetic association in the List of Phonetic Associations and select it.

4. Click the Delete button.

Tip: If you do not want to delete a phonetic association, yet you do not want it to apply to the current document, clear the adjacent check box. You can restore the association at any time by selecting the check box again. Use the Clear All and Select All buttons to quickly select or clear all the check boxes.

Word Prediction List

The Word Prediction Lists tab allows you to select which writing styles you want word prediction to use. These vocabulary categories are from detailed linguistic research and analysis of written and spoken English words.

To change the writing styles WYNN uses when predicting words and phrases:

1. From the Advanced menu, choose Word Prediction Teacher Controls.

2. Click the Word Prediction Lists tab.
3. Select the check box next to each writing style you want WYNN to use.

4. Clear the check box next to each writing style you do not want to use.

5. Click the OK button.

Creating a Custom Toolbar

To create a new toolbar containing only certain buttons that you specify, choose Custom Toolbar from the Settings menu. You can have WYNN display this toolbar instead of the standard toolbars in order to provide quick access to commonly used commands.

To create a custom toolbar:

1. From the Settings menu, choose Custom Toolbar.
The **Customize Toolbar** property page appears.

2. In the **Available Buttons** list, select the first button that you want to appear on your custom toolbar.

3. Click **Add** to place the button to the **Custom Toolbar** list.

   You can add up to 14 buttons to a custom toolbar. The order in which you choose the buttons is the order in which the buttons appears on the toolbar.

   **Tip:** To remove a button from the custom toolbar, select it in the **Custom Toolbar** list, and click the **Remove** button.
4. Select the **Show Custom Toolbar** radio button to replace the standard toolbars with your custom toolbar.

5. Click the **OK** button.

If you want to use this custom toolbar in future WYNN sessions, be sure to save your settings. Refer to the _Saving a Custom Toolbar_ section for more information. You can create as many toolbars as you need, but be sure to save each toolbar under a different name.

**Tip:** WYNN includes a number of sample custom toolbars designed to address several particular task and environments. To retrieve these toolbars, choose _Retrieve Settings_ from the _Settings_ menu.

### Saving a Custom Toolbar

After creating a custom toolbar, you can save it for future WYNN sessions.

To save the toolbar:

1. From the _Settings_ menu, choose the _Save Settings_ command.
The **Save Settings** dialog box appears.

2. Click the **More>>** button, which toggles between the **Less<<** button, and click the appropriate **Settings** radio button.

3. Type a name into the **Enter new settings file name** edit box, and click the **Save** button to save the toolbar.

In the future, it can be retrieved by:

- Clicking the **Settings** menu
- Clicking the **Retrieve Settings** command
- Selecting the toolbar from the **Name** column
Applying Preset Toolbars

WYNN includes a number of sample custom toolbars designed to address several particular task and environments.

To use WYNN’s preset toolbars:

1. From the Settings menu, choose Retrieve Settings.

   The **Retrieve Settings** dialog appears.

   ![Retrieve Settings dialog](image)

   2. Select one of the following **Custom Toolbars** from the Name column.

<table>
<thead>
<tr>
<th>Custom Toolbars</th>
<th>Toolbar Buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluent Reading</td>
<td><img src="image" alt="Read" /> <img src="image" alt="Size" /> <img src="image" alt="LineSpace" /> <img src="image" alt="Mask" /> <img src="image" alt="Rate" /> <img src="image" alt="Pause" /> <img src="image" alt="Self-Page" /> <img src="image" alt="Spell" /> <img src="image" alt="Dictionary" /> <img src="image" alt="Voice Note" /></td>
</tr>
</tbody>
</table>
3. Click the OK button. The selected toolbar appears and replaces the four default toolbars.

### Improving Auditory Processing Toolbar

This exercise is an example of how to create a customized toolbar to help students hear and improve text processing. Use these procedures to instruct students how to create an Auditory Processing toolbar for their own user account.

To create the toolbar:

1. From the Settings menu, choose Custom Toolbar.
The **Customized Toolbar** property page appears.

2. In the **Available Buttons** list, select the **Read**, **Rate**, and **Pause** icons, and click **Add** to place the icons in the Custom Toolbar list.

3. Select the **Show Custom Toolbar** radio button to replace the standard toolbars with your custom toolbar.

4. Click the **OK** button.

To save the toolbar:

1. From the **Settings** menu, choose the **Save Settings** command.
The **Save Settings** dialog box appears.

2. Click the **More>>** button, which toggles between the **Less<<** button, and click the **Custom Toolbar Settings** radio button.

3. Type a name into the **Enter new settings file name** edit box (for example, Auditory Processing Toolbar), and click the **Save** button to save the toolbar.
4. In the future, it can be retrieved by:

- Clicking the Settings menu
- Clicking the Retrieve Settings command
- Selecting the toolbar from the Name column

**Improving Vocabulary Development Toolbar**

To improve a student’s vocabulary development, you can create a custom toolbar specifically for this task. Follow these procedures to create a Vocabulary toolbar for your account. You can then instruct students to create their own Vocabulary toolbar for future assignments.
To create the toolbar:

1. From the **Settings** menu, choose **Custom Toolbar**.

![Settings menu with Custom Toolbar option highlighted]

   The **Customized Toolbar** property page appears.

2. In the **Available Buttons** list, select the **Dictionary**, **Voice Note**, and **Read** icons, and click **Add** to place the icons into the Custom Toolbar list.

![Available Buttons and Custom Toolbar lists]

3. Select the **Show Custom Toolbar** radio button to replace the standard toolbars with your custom toolbar.
To save the toolbar:

1. From the **Settings** menu, choose the **Save Settings** command.

   ![Settings Menu](image)

   The **Save Settings** dialog box appears.

2. Click the **More>>** button, and click the **Custom Toolbar Settings** radio button.

3. Type a name into the **Enter new settings file name** edit box (for example, Vocabulary Development), and click the **Save** button to save the toolbar.

   In the future, it can be retrieved by:
   
   - Clicking the Settings menu
   - Clicking the Retrieve Settings command
   - Selecting the toolbar from the Name column
Personalizing Reading Needs

There are several functions on the green **Reading Styles** toolbar that can assist a student with reading. You can create a custom toolbar that a student can retrieve that contains just those reading assistance functions.

To create a reading assistance toolbar:

1. From the **Settings** menu, choose **Custom Toolbar**.

   The **Customized Toolbar** property page appears.
2. In the **Available Buttons** list, select the **Size**, **Line Spacing**, **Word Spacing**, **Margins** and **Read** icons, and click **Add** to place the icons into the Custom Toolbar list.

![Available Buttons and Custom Toolbar](image)

3. Select the **Show Custom Toolbar** radio button to replace the standard toolbars with your custom toolbar.

4. Click the **OK** button.

To save the toolbar:

1. From the **Settings** menu, choose the **Save Settings** command.

   ![Settings menu](image)

   The **Save Settings** dialog box appears.
2. Click the More>> button, and click the Custom Toolbar Settings radio button.

3. Type a name into the **Enter new settings file name** edit box (for example, Reading Assistance), and click the **Save** button.

   The new toolbar is saved.

   In the future, it can be retrieved by:
   
   - Clicking the Settings menu
   - Clicking the Retrieve Settings command
   - Selecting the toolbar from the Name column

**Tip:** If you exit WYNN with a Custom Toolbar open, that toolbar is active the next time you log in.

   To retrieve your Default Toolbar:

   1. Click the Setting menu, and then the Custom Toolbar

   2. Click the Show Default Toolbars radio button, and then OK.

**Creating Bookmarks**

WYNN lets you bookmark important passages of text in a document for quick reference.

To bookmark text in your document:

1. Create or open an existing document.
2. Use your pointer to select a single word or a passage of text in the document, and then click the **Bookmark** button.

Several different bookmark symbols appear.

![Bookmark Symbols]

- Red Star
- Blue Circle
- Green Square
- Yellow Triangle
- Bookmark Eraser

3. Choose a bookmark symbol from the list.

WYNN places this bookmark symbol at the beginning and end of the selected text.

To erase a bookmark:

1. Click the **Bookmark** button and select the eraser at the bottom of the list. Your mouse pointer changes into a pencil eraser.

2. Click and drag the eraser over the bookmarked text.

**Tip:** You can search for bookmarks using the **Find** button (Writing Tools toolbar), or create a list of bookmarked text using the **Lists** button (Study Tools toolbar).
Highlighting Text

WYNN allows you to indicate important passages or key words in your document or a Web page just as you would highlight text in a book.

To highlight text in your document or Web page:

1. Click the Highlight button and choose a highlight color from the list. Your mouse pointer changes into a highlighter pen.

2. Click and drag the highlighter pen over text you want to highlight.

   WYNN highlights the text using the color you selected. You can highlight a single word by clicking it.

3. Click the Highlight button again when you are done highlighting text to return the cursor to normal.

To erase highlighting:

1. Click the Highlight button and then select the eraser at the bottom of the list. Your mouse pointer changes into a pencil eraser.

2. Click and drag the eraser over the highlighting you want to remove. You can erase the highlighting for an individual word by clicking the word.
Tip: You can search for highlighted text using the Find button on the yellow Writing Tools toolbar or by pressing CTRL+M while in Text View. You also can create a list of highlighted text using the Lists button on the pink Study Tools toolbar or the Web toolbar.

To print the highlighted text:

1. Click the Print button (File Management toolbar).
2. Select the Highlight Text Only radio button.

Note: You must be in Text View mode to print highlighted text.

Note: If you highlight text on a Web page, you should print the highlighted text as soon as possible.

Creating a Voice Note

Voice Notes are useful for those with stronger auditory than visual processing skills. This feature allows you to use the microphone to record a spoken message. Teachers can create Voice Notes containing questions, messages, or assignments for students. Student can use Voice Notes to record answers to the teacher’s questions, create reminders, or ask questions about the text.
To insert a voice note:

1. Make sure that your microphone is available and turned on.

2. Click the location in your document where you want to place the note, and then click the Voice Note button from the Study Tools toolbar.

The **Voice Annotation** dialog box appears.

3. Click **Record** to begin recording the note, and speak your message into the microphone.

   The bar just above the Play, Stop, and Record buttons shows the relative length of your recording.

   Click the **Stop** button when you have finished recording the voice note.

   To listen to the note, click **Play**.

   When you are finished, click **OK** to add the note.
4. A Voice Note icon appears where you added the note.

5. Double-click this icon to listen to the note.

**Tip:** You can search for Voice Notes in the document (while in Text View mode) by using the **Find** toolbar button, which appears on the yellow **Writing Tools** toolbar.

**Paraphrasing Using Voice Notes**

Paraphrasing helps students comprehend and retain information. Using WYNN’s Voice Notes is an invaluable tool when working on this learning strategy.

The following exercises, which require you to show students how to [record a Voice Note](#), can help students to improve comprehension:

When students have trouble remembering homework assignments, have them repeat the directions verbally using Voice Notes. This enables you to ensure they understand the oral directions.

Ask students to paraphrase or explain difficult information they are going to be tested on using the Voice Notes feature in WYNN. Paraphrasing helps to ensure their understanding and mastery of the material.

When learning new vocabulary, encourage students to read the definitions of the new word in the dictionary and create a sentence using the new vocabulary word in Voice Notes. Verbal repetition and sentence use supports vocabulary growth.
Creating a Text Note

Text Notes can be added to a document to provide information or key instructions about a specific passage of text.

To insert a Text Note:

1. Open your document in WYNN.

2. Click the location in your document where you want to place the note, and then click the **Note** button from the pink **Study Tools** toolbar.

   ![](Note.png)

   The **Text Annotation** dialog box appears.

3. Enter text into the Edit box.

   Click **Read** to have WYNN read the text note aloud.

   Click **Paste** to paste text from another document into the Edit box.

   Click **Cancel** to discard the text note.
4. When you are finished, click OK to add the note.

A Note icon appears where you added the note.

5. Double-click this icon to see the text note.

Tip: You can search for Text Notes in the document (while in Text View mode) by using the Find toolbar button, which appears on the yellow Writing Tools toolbar.

You can also paste text copied from other locations into the Text Note. For example, you can copy a definition from WYNN’s dictionary and paste the text into a Text Note.

Printing

To print a document in WYNN:

1. Open a document in WYNN.

2. Click the Print button that appears on the blue File Management toolbar.

3. Choose the printer you want to use to print the document, and then specify the parts of the document you want to print and the number of copies you want to create.

Note: You can choose to print only text that you have highlighted in the document by selecting the Highlight Text Only radio button. See Highlight Text for more information.
You can also choose to print only the content of all text notes in the document by selecting the Text Notes Only radio button. See Creating a Text Note for more information.

4. Click the OK button to begin printing.

**Browsing the Web Using WYNN**

WYNN allows you to browse pages on the Internet. The following section describes how to:

- Open a Web page
- Limit the number of Web pages open at a time
- Extract text from a Web page

To open a Web page:

1. Click the Go to Web button on the file management toolbar.

   ![Go to Web button](image)

   WYNN displays the Web toolbar and opens your home page.

2. You can then enter the Web address you want to go to in the address bar or search for the Web site using the Search button.

**Tip:** You can also select Go to Web from the File menu.

**Note:** If the page displays as a plain text file, then the Web page you are trying to view has probably not been formatted correctly. Web pages must include the `<html>` element.
To limit the number of Web pages open at a time:

1. Select **Web Settings** from the **Settings** menu.

2. In the **Maximum Number of Open Web Pages** section, use the combo box to specify how many Web pages you would like open at one time.
Note: You can also use this dialog to set your Home Page.

To extract text from a Web page:

1. Select the text that you want to extract.
2. Right-click on the selected text.
3. Choose "Extract to WYNN document."

WYNN will open a new document containing the selected text.
Changing a Document’s Color Settings

You can change a document’s text and background colors to help students read the document. There are two ways to change color settings: use WYNN’s preset color combinations, or manually create color combinations.

Preset Color Combinations

To use WYNN’s preset color combinations:

1. Open a document.

2. From the green Reading Styles toolbar, click the Color button.

   The color button has the following color combinations:
   - Black text on a white background (default)
   - Black text on a rose background
   - Black text on a beige background
   - Black text on a sky blue background
   - White text on a black background

3. Each time you click the Color button, WYNN cycles through the previously mentioned text and background color combinations.

4. Choose an appropriate color combination.
Changing Colors Manually

To manually change WYNN’s text and background colors:

1. From the **Settings** menu, choose **Visual Settings**.

   The **Visual Settings** property page appears.
2. Choose colors from the **Text Color** and **Background Color** list boxes.

3. Click the **OK** button to save the new colors.

**Converting Documents to MP3 or WAV File**

You can save and convert any document that you can open in WYNN as an MP3 or WAV file. This allows a user to listen to a document later using an MP3 or WAV compatible device.

To convert a document to an MP3 or WAV file:

1. Open a document using WYNN.
2. Select the **File** menu and choose the **Save to Audio** command.

The **Save Pages** dialog box appears.

3. Do one of the following:

- Select the **Save current page** radio button to convert only the current page to an MP3 or WAV file.

...OR...

- Click the **Save page range** radio button to convert the entire document or a range of pages to an MP3 file.
4. Click the **OK** button. The **Save As** dialog box appears.

![Save As dialog box](image)

5. Enter a file name in the **File name** edit box, and click the **Save** button. WYNN converts the text to audio and saves the file into your user directory as an MP3 or WAV file.

To listen to the file:

1. Click your WYNN file folder icon, which appears on your desktop.
2. Double-click the MP3 or WAV file.
3. The file opens using your default audio player.
This section describes how to perform basic tasks using WYNN.

Cutting or Copying and Pasting Text

The Cut/Paste button allows you to cut, copy, and paste text. You must enter Write mode to cut or paste text.

To copy text:

1. While in Write mode, select text in the document.

   ![Image: This indicates that Write mode is active.]

2. Click the Cut/Paste button.

   ![Image: Cut/Paste]

   The Cut, Copy, and Paste options appear.

   - Choose Cut to delete the text and move it to the Clipboard.
   - Choose Copy to leave the selected text in the document and copy it to the Clipboard.

   The Clipboard is a temporary storage area that stores text that you want to move. The Clipboard can only hold one thing at a time. For example, if you copy text and then cut different text, the Clipboard only contains the text that you cut.

3. Once you copy or cut text on to the Clipboard, you can paste it into a document (see the following procedures).

   **Tip:** You can use the shortcut keystroke CTRL+C to copy text.
To paste text:

1. Move the cursor to the place in the document where you want to insert the text.

2. Click the **Cut/Paste** button and select **Paste** to insert the contents of the Clipboard into your document.

You can continue to paste the contents of the Clipboard until you cut or copy different text. You can also paste the text into another WYNN document. Just click the **Other Docs** button to bring up the left side navigation bar (NavBar). Switch documents and then paste the text into the desired location.

**Tip:** You can paste text from WYNN into other applications, such as Microsoft Word.

**Tip:** You can use the shortcut keystroke **CTRL+V** to paste.

You can also paste text from other applications into WYNN. Use the copy, cut, and paste commands in the other applications just as you would use them in WYNN. These commands usually appear on the application's Edit menu.

**Creating a Vocabulary List Using Bookmarks**

Use the Bookmark button to select specific words from a document, and use the Lists button to add the words to a new file.
Selecting Words using Bookmarks

To select words for the vocabulary list:

1. Open a document.

2. From the Study Tools toolbar, use the Bookmark button to select words that appear in the document.

For example:

Highlight the word or phrase.

The **anthers** carry the pollen.

Click the Bookmark button, and choose a bookmark symbol.

- Red Star
- Blue Circle
- Green Square
- Yellow Triangle

1. The bookmark symbols appear at the beginning and end of the selected text.

The *anthers* carry the pollen.

2. Repeat step 2 to bookmark additional words and phrases.

When finished, go to the next section to create the vocabulary list file.
Creating the Vocabulary List using Bookmarks

WYNN allows you to create a new document containing text you have highlighted or bookmarked. You can use this feature to make lists of topic sentences, vocabulary words, useful facts, and more.

To create the vocabulary list file:

1. Click the **Lists** button and choose the type of list you want to create and how you want to sort it.

2. Choose to list the text by bookmark symbol or by the order that you bookmarked the text.

- **By Bookmark Type** - Creates a list of all bookmarked words or phrases from the original document. WYNN sorts the text into individual lists separated by bookmark type.

- **By Bookmark Order** - Creates a list of all bookmarked words or phrases arranged in the order they appear in the original document.

3. After selecting the type of list sort, WYNN creates a new document containing the bookmarked vocabulary words.

The new document uses the initial file’s name, but adds the suffix –listx, where x is 1, 2, 3, and so on. For example, Flower Parts-list1.wyn.
Finding a Word in the Dictionary

There are several ways to find the definition of a word in WYNN.

- On the **Study Tools** toolbar, select the **Dictionary** button, and choose the **Basic Dictionary** or the **Standard Dictionary**

- Select the **Tools** menu and choose the **Basic Dictionary** command

- Select the **Tools** menu and choose the **Standard Dictionary** command

- Press the **F4** function key to select the **Standard Dictionary**.

Note: If you have more than the maximum number of documents open, WYNN asks you to save your changes to the document you have accessed the least recently and then closes it.

The following procedure uses the **Dictionary** button to look up definitions for words in your WYNN document:
1. Click a word, and then from the pink **Study Tools** toolbar, click the **Dictionary** button.

2. Choose **Basic** (5th grade level) or **Standard** (7th-8th grade level).

The dictionary entry for the selected word displays as shown below.

- **Tip:** If you want to define a word within the definition, double-click the word to retrieve the definition for that word. Click the **Previous Look-up** button to return to the original word.

3. When you finish working with the dictionary, click **Close** to return to your document.
Finding a Word in the Thesaurus

There are several ways to look up a word in WYNN’s thesaurus.

- Click the **Switch to Synonyms** button on the **Dictionary** dialog box.

- Select a word and choose **Thesaurus** from the **Tools** menu.

- Select a word and choose **SHIFT+F4**.

The following procedure uses the Thesaurus command from the Tools menu to find synonyms for a selected word.

1. Select a word in your WYNN document.

2. Click the **Tools** menu and select the **Thesaurus** command.

   | Tools   | Advanced | Settings | Web | W  |
---|---------|----------|---------|-----|----|
Start Reading | F2       |          |        |     |    |
Spell Check... | F7       |          |        |     |    |
Word Count... |       |          |        |     |    |
Spell Word... | F6       |          |        |     |    |
Syllabify Word... | |          |        |     |    |
Homophones | |          |        |     |    |
Word Prediction | |          |        |     |    |
Basic Dictionary... | F4       |          |        |     |    |
Standard Dictionary... | |          |        |     |    |
Thesaurus... | Shift+F4 |          |        |     |    |

The **Thesaurus** dialog box appears.
3. Click the scroll bar in the **Synonyms** text box to view a list of synonyms for the selected word.

   Use the **Read→** button, which reads the next word in the Synonym list, and **Read←** button, which reads the previous word in the Synonym list, if you want WYNN to read the list of synonyms to you.

   Click **Switch to Definition** to start the Dictionary to see the word’s syllables and part of speech.

4. Click the **Close** button to return to your document when you are finished with the Thesaurus.

**Hearing Text as You Type**

To customize how WYNN reads documents, menus, dialog boxes, toolbar buttons, and messages.

**Note:** Some of these speech options may not be available, depending on the synthesizer you have selected. If an option is not available for your synthesizer, it is grayed-out.

1. Select the **Speech Settings** command from the **Settings** menu.

   The **Speech Settings** property page appears.
2. Use the **Read Aloud As I Type** combo box to control how WYNN repeats what you type.

Choose one of the following:

- **Off** - WYNN does not speak any text you type.
- **Character** - WYNN speaks each character you type.
- **Word** - WYNN speaks each complete word you type after you press **SPACEBAR**.
- **Both Character and Word** - WYNN speaks each character you type and then reads the word you typed.
- **Sentence** - WYNN reads back the last sentence you typed.
- **Both Word and Sentence** - WYNN speaks each word you type and then reads the entire sentence.

3. Click the **OK** button.
Controlling What WYNN Speaks

You can control which parts of the user interface that WYNN speaks aloud as you select menus, text, and toolbars and receive WYNN informational or error messages.

By default, WYNN speaks only the text of the document when you click the Read button. If you wish to have additional information spoken, do the following to select which parts of the user interface, documents, and messages WYNN speaks aloud:

1. Select the **Speech Settings** command from the **Settings** menu.

![Speech Settings Menu]

The **Speech Settings** property page appears.
2. Select one or more of the following:

<table>
<thead>
<tr>
<th>Speak What?</th>
<th>Check this item if ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>You want WYNN to read documents aloud.</td>
</tr>
<tr>
<td></td>
<td>NOTE: If this is unchecked, WYNN does not read the document aloud when you select the Read button.</td>
</tr>
<tr>
<td>Menus &amp; Dialogs</td>
<td>You want WYNN to speak aloud as you select menus and dialog boxes</td>
</tr>
<tr>
<td>Toolbar Buttons</td>
<td>You want WYNN to speak aloud the name of the toolbar button as you hover the mouse pointer over it</td>
</tr>
</tbody>
</table>
### Speak What?

<table>
<thead>
<tr>
<th>Speak What?</th>
<th>Check this item if …</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages</td>
<td>You want WYNN to speak aloud informational and error messages.</td>
</tr>
<tr>
<td>All</td>
<td>You want WYNN to read all text, user interface items, and informational and error messages aloud.</td>
</tr>
<tr>
<td>None</td>
<td>You want to mute WYNN. You want to mute WYNN so that it does not read documents aloud.</td>
</tr>
</tbody>
</table>

3. Click the **OK** button.

### Highlighting Text

WYNN allows you to indicate important passages or key words in your document or Web page just as you would highlight text in a book.

To highlight text in your document or Web page:

1. Click the **Highlight** button on the pink **Study Tools** toolbar or on the **Web** toolbar, and choose a highlight color from the list.

   Your mouse pointer changes into a highlighter pen.

2. Click and drag the highlighter pen over text you want to highlight, or use it to click and highlight a single word.

   WYNN highlights the text using the color you selected.
3. Click the **Highlight** button again when you finish highlighting text to return the pointer to normal.

To erase highlighting:

1. Click the **Highlight** button and then select the Eraser at the bottom of the list.

   Your mouse pointer changes into a pencil eraser.

2. Click and drag the eraser over the highlighting you want to remove. You can erase the highlighting for an individual word by clicking the word.

3. Click the Highlight button again when you finish erasing to return the pointer to normal.

To create a list of the highlighted text:

1. Click the **Lists** button on the **Study Tools** toolbar.

2. Choose to list the text by highlighted color or by highlight order.
- By Highlight Color - Creates a list of all highlighted words or phrases. Text highlighted in green appears first in the list, text highlighted blue appears second, and text highlighted in magenta appears last.

- By Highlight Order - Creates a list of all highlighted words or phrases in the order they appear in the original document.

3. A new file appears with the list of highlighted text.

For example:

To search for highlighted text:

**Note:** You must be in Text View to search for highlighted text or other markup.

1. Click the Find button from the Writing Tools toolbar.

2. Choose Mark Up.

The Find Markup dialog box appears.
3. Choose the **Highlight** radio button and click the **Find Next** button.

The WYNN pointer moves to the next highlighted word in the document.

4. To continue searching, click **Find Next**.

To stop searching and close the **Find Markup** dialog box, click **Cancel**.

**Tip:** You can use the keystroke CTRL+M to open the **Find Markup** dialog box.

To print the highlighted text:

1. Click the **Print** button (File Management toolbar).

2. Select the **Highlight Text Only** radio button.

**Note:** You should print Web text as soon as possible.
Listening to Voice Notes

A Voice Note is a recorded message that appears in the document. The following icon represents a Voice Note.

It may contain instructions from your teacher advising you about the exercise.

To listen to a Voice Note:

1. Locate and double-click the **Voice Note** icon.
   
The **Voice Annotation** dialog box appears and begins to play the recorded message.

2. Click the **Play** button to hear the message again.

3. Click the **Cancel** button to close the dialog box and return to your document.

Making Text Bigger

To increase the text size that appears on your screen:

1. Click the **Size** button from the green **Reading Styles** toolbar.
The print becomes larger on the screen.

2. Continue to click the **Size** button until a comfortable sized text appears. The Size function supports eight different sizes of text: 10, 12, 14, 20, 24, 28, 40, and 60 point.

Continual clicking of the **Size** button scrolls through the eight different text sizes.

**Masking a Document**

Masking is a special tool that shades certain parts of the document and Web page in order to better focus on the current line, sentence, or paragraph as it is being spoken.

You can only use masking in Text View mode.

This indicates that Text View mode is enabled.

To mask text in a document:

1. Open a document, and, if necessary, place your pointer at the beginning.

2. Select the green **Reading Styles** toolbar, and click the **Mask** button to cycle through the different masking options.

The four masking options are:

- No masking - No masking is applied to the document.

- Line masking - Shades all text except the line where the cursor is currently located.

- Sentence masking - Shades all text except the sentence where the cursor is currently located.
Paragraph masking - Shades all text except the paragraph where the cursor is currently located.

3. Do one of the following:
   - Click the text in the document and read it.
   …OR…
   - Click the Read button or press F2 to have WYNN read the text to you.

**Note:** If you turn masking on and then switch to **Write** mode, you cannot access certain WYNN commands, such as highlighting and bookmarks. Be sure to turn masking off before switching to **Write** mode if you want to use these commands. You can turn masking back on at any time.

To turn off masking:

1. Click the Mask button until no background masking appears in the document.

**Tip:** To make the shaded background and text lighter or darker, choose **Masking** from the **Settings** menu.

**Adjusting Background Masking**

The background shading used for masking is adjustable.

To make the background or text lighter or darker:

1. Choose **Masking** from the **Settings** menu.

   The **Masking** property page appears.
2. Use the **Text** slider to make the text lighter or darker.

Use the **Background** slider to make the background lighter or darker.

Use the **Preview** pane, which appears on the right of the **Masking** property page, to view your text and background adjustments.

3. After completing the adjustment, click the **Apply** button to apply the new settings or click the **OK** button to apply changes and close the property page.

**Opening a Web Page Using WYNN**

WYNN allows you to browse pages on the World Wide Web. The following section describes how to:

- [Start WYNN’s web browser](#)
- [Change your current home page](#)
- [Mask web pages](#)
- [Read web pages](#)
• **Highlight Web pages**

• **Extract Text from a Web page**

**Start WYNN’s Web Browser**

To begin browsing the Web:

1. Click the **Go To Web** button on the blue File Management toolbar.

   ![Go To Web Button](image)

   WYNN displays the Web toolbar and opens your home page.

2. Click any link on your home page to visit other Web pages. If you know the Web address of a page you want to visit, click the **Go To Page** button on the Web toolbar. Type the full Web address of the page and then click the **Go** button.

3. If you do not want to visit a specific Web address, you can search the Internet for pages containing the information you need. Click the **Search** button on the **Web** toolbar. Enter words or phrases you want to search for and click the **Search Now** button. WYNN submits the search to Google.com and displays the results. Click one of the links in the list of search results to jump to the Web page.

**Tip:** You can change the Spotlight color using the **Visual Settings** property page.
Note: If the page displays as a plain text file, then the Web page you are trying to view has probably not been formatted correctly. Web pages must include the <html> element.

Automatically complete Web addresses

WYNN can automatically complete Web addresses typed into the address bar. You must have visited the Web page before for the Auto Complete function to work.

To turn Auto Complete on or off:

1. Open the **Settings** menu and choose **Web Settings**.
2. Check or uncheck the **Auto Complete** check box.
Change your current home page

To change your current home page:

1. Choose **Web Settings** from the **Settings** menu.

The **Web Settings** property page appears.

![Web Settings property page](image_url)
2. Enter the address of the page you wish to set as your home page, or click “Use Current” if the page you are currently on is the page you would like to use as your home page.

3. Click Okay to apply these settings.

**Mask Web Pages**

To mask text in a Web page:

1. Open a Web page and place your pointer where you would like to begin reading.

2. Select the Mask button to cycle through the four different masking options.

3. Do one of the following:
   - Click the text in the document and read it.
   - OR...
     - Click the Read button or press F2 to have WYNN read the text to you.

**Tip:** See Adjusting Background Making to customize the WebMask.

**Read Web Pages**

1. Click the Read toolbar button if you want WYNN to read the page aloud.
2. You also have access to some of WYNN's study tools, such as the Dictionary, Highlight, and Lists buttons to aid your Web research.

3. In addition, you can copy text, find text in the page, print the page, or switch to another open document.

4. If you want to return to your home page, click the Home button on the Web toolbar.

5. When you are finished browsing the Internet, click the Close Web button on the Web toolbar.

To Change the Spotlight color:

1. Choose Visual Settings from the Settings menu.

2. In the Visual Settings property page change the spotlight color and spotlight background color dropdown boxes to change them.

### Read Hyperlinks

To read hyperlinks on a Web page without activating them:

1. Mouse-over or tab to the hyperlink.

2. After a slight delay, WYNN will read the text of the hyperlink

**Note:** WYNN must not be reading the page to read hyperlinks

To turn read hyperlinks off or on:
1. Open the **Settings** menu and select **Web Settings**.

2. Uncheck “Read Hyperlinks” to turn it off. Check “Read Hyperlinks” to turn it on.

3. Select **OK**.

To customize the delay before hyperlinks are read:

1. Open the **Settings** menu and select **Web Settings**.
2. In the “Delay before Reading” drop down box, select how long you want to wait before WYNN begins to read the hyperlink.

3. Select Ok.

**Highlight a Web Page**

To Highlight Text on a Web page:

1. Click the **Highlight** button on the **Web** toolbar, and choose a highlight color from the list.

   Your mouse pointer changes into a highlighter pen.
2. Click and drag the highlighter pen over text you want to highlight, or use it to click and highlight a single word. WYNN highlights the text using the color you selected.

3. Click the Highlight button again when you finish highlighting text to return the pointer to normal.

**Tip:** Extract text from Web pages as soon as possible because online text frequently changes.

### Extract Text from a Web page

To Extract text from a Web page:

1. Click the Extract button.

2. Choose how you want highlights ordered or what you want to extract:

   - **By Highlight Color** - Creates a list of all highlighted words or phrases. Text highlighted in green appears first in the list, text highlighted blue appears second, and text highlighted in magenta appears last. This choice is useful for categorizing information.
   - **By Highlight Order** - Creates a list of all highlighted words or phrases in the order they appear in the original document. This choice is useful for creating study guides with key points and supporting points.
- All Text - Extracts all text on the Web page to a document. You can extract the text into a new document or append it to an existing document.

- Selected Text – Extracts selected text on the Web page to a document. You can extract the text into a new document or append it to an existing document.

After selecting, WYNN creates a new document containing the highlighted or bookmarked text. If you have more than the maximum number of documents open, WYNN asks you to save your changes to the document you have accessed the least recently and then closes it.

Organizing Ideas with Outlines

Outlines can help you organize the topics and supporting points of your documents. You can use outlines to plan the organization of research papers, summarize study materials, create plots for stories, and more.

To create a new outline:

1. Click the Outlines button from the yellow Writing Tools toolbar.

WYNN opens a new outline document in Write mode. WYNN names the new document for you (for example, Document-outline1.wyn), but you can change this name when you save the outline.

Note: If you already have the maximum number of documents open, WYNN prompts you to save your changes to the document you have accessed the least recently and then closes it.
2. The new document is blank except for the first line; it contains the text [Title].

3. Type a new title for the outline, and press ENTER.

WYNN automatically numbers the first line in the outline with the Roman numeral one (I).

4. Type the information that you want to appear at this level of the outline and then press ENTER.

WYNN automatically numbers the next line with the Roman numeral two (II).

5. Continue adding lines to the outline until you are finished. You can press TAB to begin a new outline level. Use the Adjust button to move items in the outline.

WYNN has five outline levels:

- Outline Level 1 - Roman numerals (I, II, III...)
- Outline Level 2 - Upper case letters (A, B, C...)
- Outline Level 3 - Arabic numbers (1, 2, 3...)
- Outline Level 4 - Lower case letters (a, b, c...)
- Outline Level 5 - Lower case Roman numerals (i, ii, iii...)

Tip: If you need additional assistance with WYNN's outline feature, refer to the Outline Tutorial in WYNN's online help file.
Predicting the Next Word

Word prediction helps you write by making spelling suggestions and anticipating the next word you are going to type. This feature can help you with spelling, grammar, and formulating sentences.

To start word prediction:

1. Click the **Predict** button from the yellow *Writing Tools* toolbar to activate WYNN's Word Prediction feature.

The first time you start Word Prediction during a session, WYNN loads the word list. After the word list loads, WYNN displays a small prediction box on your screen.

The prediction box follows your cursor as you type. If your cursor is within or is adjacent to a word, Word Prediction suggests alternative spellings for the word.

If your cursor is not within or is adjacent to a word, Word Prediction suggests ideas for the next word in your sentence.

2. To insert a word that appears in the prediction box, click the word you want to insert, or press the corresponding function key (**F1**, **F2**, **F3**, etc.).
WYNN inserts the specified word into your document.

3. If you want WYNN to read the list of words to you, click the **Speak List** button.

You can also right-click a word in the prediction box to have WYNN read the word aloud.

**Note:** To modify the behavior and appearance of the Word Prediction feature, choose **Word Prediction Settings** from the **Settings** menu. To customize the word and phrase suggestions provided by the Word Prediction feature, choose **Word Prediction Teacher Controls** from the **Advanced** menu.

## Printing a Document in WYNN

To print using WYNN:

1. Click the **Print** button from the blue **File Management** toolbar to print the active document.

2. Choose the printer you want to use to print the document. If necessary, specify which parts of the document you want to print and the number of copies you want to create.

3. Click **OK** to begin printing.
Proofreading Your Writing Using Speech

A review of your document with WYNN’s speech function turned on is one way of finding and correcting errors.

To proofread your document:

1. Open your document and make sure that your computer’s speakers are turned on or that your headphones are plugged in.

2. Place your mouse pointer at the beginning of your document, and click the Read button.

    WYNN reads your document.

To change WYNN’s reading speed:

3. Click the Speech Settings command from the Settings menu.

    The Speech Settings property page appears.
4. Change the **Rate** setting using either the slider or your keyboard’s arrow keys.

   The speech rate appears below the slider scale as words per minute (WPM).

5. Click the **Test** button to verify if the speech rate is too slow or too fast.

6. Click the **OK** button when you are satisfied with the speech rate.

**Reading Syllables**

You can use WYNN to divide words into individual syllables and display the word's phonetic spelling.

To see the syllables and the phonetic spelling of a word:
1. Click the word, and then click the **Syllables** button that appears on the **Study Tools** toolbar.

The **Syllabify** dialog box appears.

![Syllabify Dialog Box](image)

2. Click **Read Word** to have WYNN speak the word aloud.

3. Click **Read Phonetics** to have WYNN speak the word’s phonetic pronunciation aloud.

4. Click **Close** when you are finished to return to your document.

### Check Your Spelling as You Type

WYNN can check for misspellings as you type. The misspelled words appear in blue text for easy identification and quick correction.

To turn on spell checking as you type:

1. From the **Settings** menu, select the **General Settings** command.

   The **General Settings** property page appears.
2. Choose Check spelling as I type.

3. Open a new or existing document and begin typing.

If you misspell a word, it appears in blue text. For example,

This is a misspelled word.

4. Right-click your mouse on the misspelled word.

The Spelling options appear.
5. Do one of the following:
   - Select the appropriate spelling
   - Ignore the misspelled word
   - Add the word to your personal dictionary
   - Open WYNN’s Spell Checker (see Spell Checking Your Document)
   - After choosing the appropriate option, look for the next misspelled word and repeat this process, or continue typing.

Spell Checking Your Document

To check your document for spelling errors:

1. Place your mouse pointer at the beginning of the document.

2. Do one of the following:
   - Click the F7 function key

...OR...
Click the **Spell Check** command from the **Tools** menu.

WYNN checks your document for spelling errors. If an error is found, the **Spell Check** dialog appears. For example,

![Spell Check dialog](image)

3. Select one of the following options.

<table>
<thead>
<tr>
<th>Edit box or Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Not Found</td>
<td>Shows the misspelled word.</td>
</tr>
<tr>
<td>Replace With</td>
<td>Use the List box arrow to view suggested spelling corrections.</td>
</tr>
<tr>
<td>Spell Misspelled Word</td>
<td>Click to have WYNN speak aloud, spell aloud, and speak aloud again the misspelled word.</td>
</tr>
<tr>
<td>Spell Replacement Word</td>
<td>Click to have WYNN speak aloud, spell aloud, and speak aloud the replacement word.</td>
</tr>
<tr>
<td>Edit box or Button</td>
<td>Function</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Ignore</td>
<td>WYNN does not correct the misspelling of this particular word.</td>
</tr>
<tr>
<td>Ignore All</td>
<td>WYNN does not correct the misspelling of this word throughout the document for the remainder of the session.</td>
</tr>
<tr>
<td>Replace</td>
<td>WYNN replaces the misspelled word with the word chosen in the Replace With list box.</td>
</tr>
<tr>
<td>Replace All</td>
<td>WYNN replaces the misspelled word with the word chosen in the Replace With list box throughout the document.</td>
</tr>
<tr>
<td>Add to Dictionary</td>
<td>WYNN adds the word that appears in the Word Not Found list box to the user’s personal dictionary.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Spell Check dialog box and returns you to the document.</td>
</tr>
</tbody>
</table>

4. After you choose to ignore, replace, or add the word to WYNN's dictionary, the spell checker searches for the next misspelled word.

The message “Spell checking is complete” appears when WYNN finishes.

**Spelling a Word**

If you are unfamiliar with a word in a document, use the Spell function to have WYNN speak, spell, and speak again the word.
To spell a word:

1. Click a word in your document.

2. Click the Spell button that appears on the pink Study Tools toolbar.

3. The Spell dialog appears.

   WYNN speaks the word aloud, spells the word, and then speaks the word again.

4. Click the Repeat button to hear the spelling again.

5. Click the Close button when finished.

Choosing the Correct Word

A homophone is two or more words that are pronounced alike, but have different meaning and often-different spelling. Use WYNN’s Homophone function to verify the correct word usage in your document.

To check your document for homophones:

1. Open a document in WYNN.

2. Do one of the following to start the homophone function:
- Click the **Homophones** button that appears on the yellow **Writing Tools** toolbar.

...OR...

- Select the **Homophones** command from the **Tools** menu.

WYNN searches your document, from your current mouse pointer position, for homophones. When one is found, the **Homophones: Sound-alike Words** dialog box appears. It contains a list of homophones and definitions, which allows you to select and use the appropriate word.

3. Click each homophone that appears and read its definition in the **Definition** list box, or click the **Read Definition** button to have WYNN speak the definition to you.

   You can also click on the **Read Sentence** button to have WYNN speak the sentence the homophone was found in.

4. Click the **Skip** button if the correct word is used. You can also choose **Skip All** to skip all instances of the homophone in the document.
If the wrong word is used, choose the word from the Homophones list box and click Replace.

After selecting, WYNN continues to search for the next homophone.

5. To stop the homophone search, click Close to return to your document.
# System Requirements

The following is the minimum software and hardware required for WYNN single-user and client installations.

<table>
<thead>
<tr>
<th>System Components</th>
<th>Minimum System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WYNN Single User and Client</strong></td>
<td></td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 7 (64-bit and 32-bit), Windows Vista (64-bit and 32-bit), or Windows XP (32-bit)</td>
</tr>
<tr>
<td>Web Browser</td>
<td>Windows Internet Explorer 6.0 or later</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium 400 MHz or better processor</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>650 MB of available hard disk space or 1 GB with RealSpeak Solo Voices (plus additional space for document storage)</td>
</tr>
<tr>
<td>Memory</td>
<td>128 MB RAM or 256 MB with RealSpeak Solo Voices</td>
</tr>
<tr>
<td>CD-ROM Drive</td>
<td>CD-ROM drive or DVD-ROM drive for software installation</td>
</tr>
<tr>
<td>Sound</td>
<td>SoundBlaster 16 compatible with microphone and speakers or headphones</td>
</tr>
<tr>
<td>System Components</td>
<td>Minimum System Requirements</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Video</td>
<td>Video card and monitor capable of at least 800x600 resolution with 16-bit high color mode or greater</td>
</tr>
<tr>
<td><strong>WYNN Single User and Client</strong></td>
<td></td>
</tr>
<tr>
<td>Internet Connection</td>
<td>Local area network, modem, or DSL connection to the Internet for product activation</td>
</tr>
<tr>
<td>Scanner</td>
<td>TWAIN or WIA compatible scanner (optional for WYNN Wizard; not required for WYNN Reader)</td>
</tr>
<tr>
<td><strong>Network WYNN Client Additions</strong></td>
<td></td>
</tr>
<tr>
<td>Network Connectivity</td>
<td>TCP/IP Network connectivity to the License Server Microsoft Network Connectivity between the client and the WYNN server</td>
</tr>
<tr>
<td><strong>License Server Requirements</strong></td>
<td></td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 2000 or later</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium processor</td>
</tr>
<tr>
<td>Memory</td>
<td>64 MB of RAM</td>
</tr>
<tr>
<td>Video</td>
<td>800x600, 16-bit high color display</td>
</tr>
<tr>
<td>System Components</td>
<td>Minimum System Requirements</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Network</td>
<td>TCP/IP Network connectivity</td>
</tr>
<tr>
<td><strong>Network WYNN Server</strong></td>
<td></td>
</tr>
<tr>
<td>Hard Disk</td>
<td>650 MB of disk space (2.5 GB with RealSpeak Solo Voices)</td>
</tr>
<tr>
<td></td>
<td>Additional disk space for user folders</td>
</tr>
</tbody>
</table>
WYNN Shortcut Keys

This section lists keystrokes you can press to perform various functions in WYNN. In addition to these keystrokes, all standard Microsoft Windows shortcut keys are available.

General Commands

<table>
<thead>
<tr>
<th>General Commands</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start WYNN</td>
<td>ALT+CTRL+W</td>
</tr>
<tr>
<td>Quit WYNN</td>
<td>ALT+F4</td>
</tr>
<tr>
<td>Switch between Text View and Exact View</td>
<td>CTRL+SHIFT+V</td>
</tr>
<tr>
<td>Show/Hide Menu Bar</td>
<td>SHIFT+F3</td>
</tr>
<tr>
<td>Show/Hide Status Bar</td>
<td>SHIFT+F5</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
</tbody>
</table>

Speech Commands

<table>
<thead>
<tr>
<th>Speech Commands</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>All speech options (text, toolbars, menus, dialog boxes, messages)</td>
<td>ALT+G, P, ALT+A</td>
</tr>
<tr>
<td>Begin/Stop Reading</td>
<td>F2</td>
</tr>
<tr>
<td>Toolbars</td>
<td>ALT+G, P, ALT+T</td>
</tr>
<tr>
<td>Menus and Dialog boxes</td>
<td>ALT+G, P, ALT+M</td>
</tr>
</tbody>
</table>
### File Management Commands

<table>
<thead>
<tr>
<th>File Management Commands</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open File</td>
<td>CTRL+O</td>
</tr>
<tr>
<td>Close Document</td>
<td>CTRL+F4 or CTRL+W</td>
</tr>
<tr>
<td>Create New Document</td>
<td>CTRL+N</td>
</tr>
<tr>
<td>Save Document</td>
<td>CTRL+S</td>
</tr>
<tr>
<td>Print</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>View Document Properties</td>
<td>CTRL+R</td>
</tr>
</tbody>
</table>

### Reading and Editing Commands

<table>
<thead>
<tr>
<th>Reading and Editing Commands</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Reading</td>
<td>F2</td>
</tr>
<tr>
<td>Switch between Read-only Mode and Edit Mode</td>
<td>CTRL+E</td>
</tr>
<tr>
<td>Go to Page</td>
<td>CTRL+G</td>
</tr>
<tr>
<td>Undo</td>
<td>CTRL+Z</td>
</tr>
<tr>
<td>Copy Selected Text</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Cut Selected Text</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Paste Text from Clipboard</td>
<td>CTRL+V</td>
</tr>
<tr>
<td>Select All</td>
<td>CTRL+A</td>
</tr>
<tr>
<td>Delete Selected Text</td>
<td>DELETE</td>
</tr>
<tr>
<td>Bold Selected Text</td>
<td>CTRL+B</td>
</tr>
</tbody>
</table>
### Reading and Editing Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Italicize selected Text</td>
<td>CTRL+I</td>
</tr>
<tr>
<td>Underline Selected Text</td>
<td>CTRL+U</td>
</tr>
<tr>
<td>Find Text</td>
<td>CTRL+F</td>
</tr>
<tr>
<td>Find/Replace Text</td>
<td>CTRL+H</td>
</tr>
<tr>
<td>Insert Page Break</td>
<td>CTRL+ENTER</td>
</tr>
<tr>
<td>Delete Page Break</td>
<td>CTRL+SHIFT+ENTER</td>
</tr>
<tr>
<td>Delete Current Page</td>
<td>CTRL+DELETE</td>
</tr>
<tr>
<td>Look Up Selected Word in the Standard Dictionary</td>
<td>F4</td>
</tr>
<tr>
<td>Look Up Selected Word in the Thesaurus</td>
<td>SHIFT+F4</td>
</tr>
<tr>
<td>Spell Check</td>
<td>F7</td>
</tr>
<tr>
<td>Spell Word</td>
<td>F6</td>
</tr>
</tbody>
</table>

### Mark-up Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Mark-up</td>
<td>CTRL+M</td>
</tr>
<tr>
<td>Highlight Selected Text</td>
<td>F8</td>
</tr>
<tr>
<td>Insert Bookmark</td>
<td>F9</td>
</tr>
<tr>
<td>Insert Text Note</td>
<td>F10</td>
</tr>
<tr>
<td>Insert Voice Note</td>
<td>F11</td>
</tr>
</tbody>
</table>
## Scanning Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan a Page</td>
<td>F3</td>
</tr>
<tr>
<td>Switch between Text View and Exact View</td>
<td>CTRL+SHIFT+V</td>
</tr>
<tr>
<td>Document Clean-up</td>
<td>SHIFT+F7</td>
</tr>
<tr>
<td>Enable Dynamic Zoning and Show Current Zones</td>
<td>CTRL+F5</td>
</tr>
<tr>
<td>Redefine Zones on Current Page</td>
<td>CTRL+D</td>
</tr>
<tr>
<td>Re-recognize Document</td>
<td>CTRL+Q</td>
</tr>
</tbody>
</table>

## Study Tools Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dictionary</td>
<td>F4</td>
</tr>
<tr>
<td>Spell Current Word</td>
<td>F6</td>
</tr>
<tr>
<td>Spell Checker</td>
<td>F7</td>
</tr>
<tr>
<td>Highlight</td>
<td>F8</td>
</tr>
<tr>
<td>Insert Bookmark</td>
<td>F9</td>
</tr>
<tr>
<td>Create Text Note</td>
<td>F10</td>
</tr>
<tr>
<td>Create Voice Note</td>
<td>F11</td>
</tr>
</tbody>
</table>
WYNN Menus

This section lists each command available on the WYNN main menu bar. The second column lists the shortcut keys you can press to quickly activate the corresponding command.

**File Menu (ALT+F)**

<table>
<thead>
<tr>
<th>File Menu Commands</th>
<th>Access Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>ALT+F, N</td>
</tr>
<tr>
<td>Open</td>
<td>ALT+F, O</td>
</tr>
<tr>
<td>Close</td>
<td>ALT+F, C</td>
</tr>
<tr>
<td>Save</td>
<td>ALT+F, S</td>
</tr>
<tr>
<td>Save As</td>
<td>ALT+F, A</td>
</tr>
<tr>
<td>Save to Audio</td>
<td>ALT+F, D</td>
</tr>
<tr>
<td>Go to Web</td>
<td>ALT+F, W</td>
</tr>
<tr>
<td>Save Pages</td>
<td>ALT+F, G</td>
</tr>
<tr>
<td>Enable Multi-user Logins</td>
<td>ALT+F, E</td>
</tr>
<tr>
<td>Login Different User</td>
<td>ALT+F, L</td>
</tr>
<tr>
<td>Append File to Current Document</td>
<td>ALT+F, F</td>
</tr>
<tr>
<td>Print</td>
<td>ALT+F, P</td>
</tr>
<tr>
<td>Print Preview</td>
<td>ALT+F, V</td>
</tr>
<tr>
<td>Print Setup</td>
<td>ALT+F, U</td>
</tr>
<tr>
<td>Document Properties</td>
<td>ALT+F, R</td>
</tr>
<tr>
<td>Exit</td>
<td>ALT+F, X</td>
</tr>
</tbody>
</table>
## Edit Menu (ALT+E)

<table>
<thead>
<tr>
<th>Edit Menu Commands</th>
<th>Access Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Mode/Read-only Mode</td>
<td>ALT+E, E</td>
</tr>
<tr>
<td>Undo</td>
<td>ALT+E, U</td>
</tr>
<tr>
<td>Cut</td>
<td>ALT+E, T</td>
</tr>
<tr>
<td>Copy</td>
<td>ALT+E, C</td>
</tr>
<tr>
<td>Paste</td>
<td>ALT+E, P</td>
</tr>
<tr>
<td>Delete</td>
<td>ALT+E, D</td>
</tr>
<tr>
<td>Select All</td>
<td>ALT+E, S</td>
</tr>
<tr>
<td>Bold</td>
<td>ALT+E, B</td>
</tr>
<tr>
<td>Italic</td>
<td>ALT+E, I</td>
</tr>
<tr>
<td>Underline</td>
<td>ALT+E, U</td>
</tr>
<tr>
<td>Find Text...</td>
<td>ALT+E, F</td>
</tr>
<tr>
<td>Find/Replace Text...</td>
<td>ALT+E, R</td>
</tr>
<tr>
<td>Find Mark-up...</td>
<td>ALT+E, M</td>
</tr>
<tr>
<td>Go to Page..</td>
<td>ALT+E, G</td>
</tr>
<tr>
<td>Renumber Pages...</td>
<td>ALT+E, A</td>
</tr>
<tr>
<td>Insert Page Break</td>
<td>ALT+E, I</td>
</tr>
<tr>
<td>Delete Page Break</td>
<td>ALT+E, L</td>
</tr>
<tr>
<td>Move Page...</td>
<td>ALT+E, O</td>
</tr>
<tr>
<td>Delete Current Page</td>
<td>ALT+E, N</td>
</tr>
<tr>
<td><strong>Edit Menu Commands</strong></td>
<td><strong>Access Keys</strong></td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Create Outline</td>
<td>ALT+E, O</td>
</tr>
<tr>
<td>Outline Adjustments</td>
<td>ALT+E, J</td>
</tr>
</tbody>
</table>

### Scan Menu (ALT+S)

<table>
<thead>
<tr>
<th><strong>Scan Menu Commands</strong></th>
<th><strong>Access Keys</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Page</td>
<td>ALT+S, S</td>
</tr>
<tr>
<td>Scan and Replace Current Page</td>
<td>ALT+S, R</td>
</tr>
<tr>
<td>Scan and Insert New Page</td>
<td>ALT+S, I</td>
</tr>
<tr>
<td>Recognize Columns</td>
<td>ALT+S, Z</td>
</tr>
<tr>
<td>Color Scanning</td>
<td>ALT+S, C</td>
</tr>
<tr>
<td>2-page Scanning</td>
<td>ALT+S, 2</td>
</tr>
<tr>
<td>Most Accurate Scanning</td>
<td>ALT+S, A</td>
</tr>
<tr>
<td>Fastest Scanning</td>
<td>ALT+S, F</td>
</tr>
</tbody>
</table>

### View Menu (ALT+V)

<table>
<thead>
<tr>
<th><strong>View Menu Commands</strong></th>
<th><strong>Access Keys</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Exact View/Text View</td>
<td>ALT+V, V</td>
</tr>
<tr>
<td>Hide Study Tools in Exact View</td>
<td>ALT+V, H</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>ALT+V, M</td>
</tr>
<tr>
<td>Toolbar</td>
<td>ALT+V, T</td>
</tr>
<tr>
<td>Status Bar</td>
<td>ALT+V, S</td>
</tr>
<tr>
<td>Document Navigation</td>
<td>AVT+V, D</td>
</tr>
<tr>
<td>View Menu Commands</td>
<td>Access Keys</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Zoom Exact View</td>
<td>ALT+V, Z</td>
</tr>
<tr>
<td>Page Scrolling</td>
<td>ALT+V, P</td>
</tr>
</tbody>
</table>

**Tools Menu (ALT+T)**

<table>
<thead>
<tr>
<th>Tools Menu Commands</th>
<th>Access Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Reading</td>
<td>ALT+T, S</td>
</tr>
<tr>
<td>Spell Check</td>
<td>ALT+T, P</td>
</tr>
<tr>
<td>Spell Check As I Type</td>
<td>ALT+T, E</td>
</tr>
<tr>
<td>Word Count...</td>
<td>ALT+T, R</td>
</tr>
<tr>
<td>Spell Word...</td>
<td>ALT+T, W</td>
</tr>
<tr>
<td>Syllabify Word...</td>
<td>ALT+T, Y</td>
</tr>
<tr>
<td>Homophones</td>
<td>ALT+T, M</td>
</tr>
<tr>
<td>Word Prediction</td>
<td>ALT+T, O</td>
</tr>
<tr>
<td>Basic Dictionary...</td>
<td>ALT+T, B</td>
</tr>
<tr>
<td>Standard Dictionary...</td>
<td>ALT+T, D</td>
</tr>
<tr>
<td>Thesaurus...</td>
<td>ALT+T, T</td>
</tr>
<tr>
<td>Start Highlight</td>
<td>ALT+T, H</td>
</tr>
<tr>
<td>Highlighter Pens</td>
<td>ALT+T, G</td>
</tr>
<tr>
<td>Lists</td>
<td>ALT+T, L</td>
</tr>
<tr>
<td>Insert Bookmark</td>
<td>ALT+T, I</td>
</tr>
<tr>
<td>Bookmark Type</td>
<td>ALT+T, B</td>
</tr>
</tbody>
</table>
### Tools Menu Commands

<table>
<thead>
<tr>
<th>Tools Menu Commands</th>
<th>Access Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Text Note...</td>
<td>ALT+T, N</td>
</tr>
<tr>
<td>Insert Voice Note...</td>
<td>ALT+T, V</td>
</tr>
</tbody>
</table>

### Advanced Menu (ALT+A)

<table>
<thead>
<tr>
<th>Advanced Menu Commands</th>
<th>Access Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pronunciation Dictionary</td>
<td>ALT+A, P</td>
</tr>
<tr>
<td>Dynamic Zoning</td>
<td>ALT+A, Z</td>
</tr>
<tr>
<td>Document Cleanup</td>
<td>ALT+A, D</td>
</tr>
<tr>
<td>OCR Correction...</td>
<td>ALT+A, O</td>
</tr>
<tr>
<td>Scanner Selection...</td>
<td>ALT+A, S</td>
</tr>
<tr>
<td>Teacher Lockout</td>
<td>ALT+A, T</td>
</tr>
<tr>
<td>Word Prediction Teacher Controls...</td>
<td>ALT+A, W</td>
</tr>
</tbody>
</table>

### Settings Menu (ALT+G)

<table>
<thead>
<tr>
<th>Settings Menu Commands</th>
<th>Access Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Settings...</td>
<td>ALT+G, S</td>
</tr>
<tr>
<td>Retrieve Settings...</td>
<td>ALT+G, R</td>
</tr>
<tr>
<td>Delete Settings...</td>
<td>ALT+G, D</td>
</tr>
<tr>
<td>Speech Settings...</td>
<td>ALT+G, P</td>
</tr>
<tr>
<td>Visual Settings...</td>
<td>ALT+G, V</td>
</tr>
<tr>
<td>Scanning Settings...</td>
<td>ALT+G, C</td>
</tr>
<tr>
<td>General Settings...</td>
<td>ALT+G, G</td>
</tr>
</tbody>
</table>
### Settings Menu Commands

<table>
<thead>
<tr>
<th>Settings Menu Commands</th>
<th>Access Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Masking...</td>
<td>ALT+G, M</td>
</tr>
<tr>
<td>Differential Coloring...</td>
<td>ALT+G, O</td>
</tr>
<tr>
<td>Word Prediction...</td>
<td>ALT+G, I</td>
</tr>
<tr>
<td>Custom Toolbar...</td>
<td>ALT+G, T</td>
</tr>
<tr>
<td>Web Settings...</td>
<td>ALT+G, W</td>
</tr>
</tbody>
</table>

### Web Menu (ALT+B)

<table>
<thead>
<tr>
<th>Web Menu Commands</th>
<th>Access Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>ALT+B, B</td>
</tr>
<tr>
<td>Forward</td>
<td>ALT+B, F</td>
</tr>
<tr>
<td>Stop</td>
<td>ALT+B, T</td>
</tr>
<tr>
<td>Refresh</td>
<td>ALT+B, R</td>
</tr>
<tr>
<td>Home</td>
<td>ALT+B, H</td>
</tr>
<tr>
<td>Close Web</td>
<td>ALT+B, C</td>
</tr>
<tr>
<td>Search the Web</td>
<td>ALT+B, W</td>
</tr>
<tr>
<td>Go To Web Page...</td>
<td>ALT+B, G</td>
</tr>
<tr>
<td>History...</td>
<td>ALT+B, Y</td>
</tr>
<tr>
<td>Favorites...</td>
<td>ALT+B, A</td>
</tr>
</tbody>
</table>

### Window Menu (ALT+W)

<table>
<thead>
<tr>
<th>Window Commands</th>
<th>Access Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Document</td>
<td>ALT+W, N</td>
</tr>
</tbody>
</table>
## Help Menu (ALT+H)

<table>
<thead>
<tr>
<th>Help Menu Commands</th>
<th>Access Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search for help on...</td>
<td>ALT+H, S</td>
</tr>
<tr>
<td>WYNN Help...</td>
<td>ALT+H, H</td>
</tr>
<tr>
<td>About WYNN...</td>
<td>ALT+H, A</td>
</tr>
</tbody>
</table>
Activation Options

Software activation is an easy, one-time process that uses a 20-character Authorization code to help Freedom Scientific verify your product’s license. The Authorization code is available on the Authorization CD and WYNN’s CD package. Use the Authorization CD to copy the code to your computer. This saves the time and trouble of having to manually type the 20-character code during the Activation process.

If you do not have immediate Internet access, use the procedures in this chapter to activate your product.

Before You Begin:

1. Locate your 20-character Authorization number, which appears on the WYNN product packaging.

2. Install your 20-character Authorization number as previously described in the Copying the WYNN Authorization Number section.

3. There are several ways to activate WYNN. Determine which method you want to use. For example:
   - Use the Internet to connect directly to Freedom Scientific and use the automated activation process. This is the fastest method and is recommended, as described in the WYNN Installation Process section.
   - Call Freedom Scientific’s Customer Support and request that an Activation License code be sent to you by e-mail or on a CD.
   - Send a fax to Freedom Scientific’s Customer Support and request that an Activation License code be sent to you by e-mail or on a CD.
- Use another computer with Internet connectivity to download an Activation License code from FSActivate.com. Once it is received, it can be copied to a disk or CD-ROM and used to activate WYNN.

**Starting the Activation Process**

Until you activate WYNN, the Activation dialog box appears each time you try to open the WYNN application.

To start the activation process:

1. Select the WYNN application shortcut from the desktop.
2. From the WYNN Activation dialog box, click **Activate**.
3. A WYNN dialog box appears. It contains the various activation methods.
If you do not have immediate Internet access to activate the WYNN application, choose one of the following activation methods:

- Activating by telephone
- Activating by fax
- Activating using FSActivate.com

**Activating by Telephone**

There are two ways to request activation by calling Freedom Scientific directly.

- Call and request that an Activation code be emailed to you.
- Call and request that an Activation code be mailed to you.

**Note:** Activation by mail takes several days to complete since a CD must be mailed to you.
Requesting an Activation Code by Telephone

To activate your product after receiving the Activation code in an email:

1. From the WYNN Activation dialog, select **Telephone to receive activation by mail**, and click **Next**.

![WYNN Activation dialog](image)

2. Record your Locking code and the Customer Service phone number. Click **Quit** and exit WYNN activation.
Keep your Locking code, Customer Service phone number, and Authorization number, which also appears on your WYNN CD package, in a safe place. You will need this information later when calling Freedom Scientific.

3. Call Customer Service (727-803-8015), request an Activation License code, and provide your Locking code and Authorization number.

4. If activating using an Activation code received by email,
   - When the email arrives, start WYNN, select Activate, select Telephone to receive activation by mail, and click Next.
   - Copy the 100-plus character code from the email message, and paste it into the Activation License Code edit box. Click Next.
If activating using an Activation code received by mail,

- When the Activation License code CD arrives, insert it into the computer’s CD-ROM drive, and let the auto-run feature start the Activation program.

- When requested, click **Activate Using Authorization CD**, and follow the on-screen instructions. If necessary, enter your Locking code and Authorization number when requested.

If activation is successful, a confirmation message appears.

5. Click **Finished**, which completes the activation.

If the activation fails, a detailed error message appears that recommends you verify or reenter your authorization code, or that you contact Freedom Scientific for assistance.
Activating by FAX

You can print, complete, and fax a request form to Freedom Scientific's Customer Service requesting that an Activation License code be sent to you by email or postal service.

Note: This method of activation takes several days to complete since a CD must be mailed to you.

Requesting an Activation Code by Fax

To receive the Activation code using email:

1. From the WYNN Activation dialog, select Telephone to receive activation by mail, and click Next.

2. Record your Locking code.
Keep your Locking code and Authorization number, which appears on your WYNN product box, in a safe place. You will need this information later.

3. **Click Back**, select **Fax**, and click **Next**.
The Activation License code request form appears.

4. Print and complete the form, and fax it to Customer Service (727-803-8001). Make sure that you enter your Authorization number, and if requesting an Authorization number by email, a valid email address.

5. Quit the WYNN Activation dialog box.

6. If activating by email,
   - When the Activation License code arrives by e-mail, start WYNN, select **Activate**, select **Telephone to receive activation by mail**, and click **Next**.
   - Copy the 100-plus character Activation License code from the e-mail message, and paste it into the **Activation License Code** edit box. Click **Next**.
If activating by mail,

- When the Activation License code CD arrives, insert it into the computer’s CD-ROM drive, and let the auto-run feature start the Activation program.

- When requested, click **Activate Using Authorization CD**, and follow the on-screen instructions. If necessary, enter your Locking code and Authorization number when requested.

If activation is successful, a confirmation message appears.

7. **Click Finished**, which completes activation.

If activation fails, a detailed error message appears that recommends you verify or reenter your activation license code, or that you contact Freedom Scientific for assistance.
Activating using FSActivate.com

Another method for obtaining an Activation License code is to download the code using another person’s computer, and then copying the code to your computer using a floppy disk or CD-ROM.

**Note:** The other person’s computer must have Internet access.

Using your computer:

1. From the WYNN Activation dialog, select **Activation generated from www.FSActivate.com**, and click **Next**.

2. Record your Locking code.
Keep your Locking code and Authorization number, which appears on your WYNN CD package, in a safe place. You will need this information later.

3. **Quit the WYNN Activation** dialog box.

Using the other person’s computer:

1. Use a trusted third party’s computer with Internet access to connect to Freedom Scientific’s product activation page (http://www.FSActivate.com).

2. Click **Continue**, and scroll down until the **Authorization number** and **Locking Code** edit boxes appear.

3. Enter your Authorization number and Locking code, and click **Submit License Request**.

4. Save the generated License code as an HTML or text file to a floppy disk or CD-ROM and transport to your computer.
Using your computer:

1. At your computer, start WYNN, select Activation generated from www.fsactivate.com to receive activation by mail.

2. Insert the floppy disk or CD-ROM into your computer, and copy the 100-plus character License code from the file.

3. Paste the entire License code into the Activate License Code edit box, and click Next.

If activation is successful, a confirmation message appears.

4. Click Finished, which completes activation.

If activation fails, a detailed error message appears that recommends you verify or reenter your Authorization number, or that you contact Freedom Scientific for assistance.
Activating using the Activation Media Image Creator Program

The Activation Media Image Creator program provides an alternative method if you must activate several computers that do not have access to the internet.

To activate these computers, you need:

- One computer that can access the Internet and download the Activation Media Image Creator program
- The Locking codes and the Authorization numbers of the computers that require activation

Do the following to download this program:

2. Select the FS Product Activation Site link and then select Continue.
3. Select the Activation Media Image Creator link.
4. Read the on-screen instructions and download the Activation Media Image Creator program. Follow the on-screen instructions provided with the program.
Activating the License Server through a Software Firewall

**Note:** The following provides a general overview for reconfiguring your firewall settings. For a specific example of how to configure your firewall settings using Windows Firewall, refer to Configuring Windows Firewall.

**General Overview**

If your firewall software prevents you from activating WYNN using the Internet, reconfigure the firewall to allow the following files to run:

- FSActivate.exe
- CAUtil.exe
- CAUtil.enu

**Note:** Temporarily disable Windows firewall while performing this procedure.

Once you have reconfigured your firewall, retry the activation process. The following is a complete list of all files that need to be allowed by the firewall when using WYNN:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Connection Type</th>
<th>Incoming Port</th>
<th>Outgoing Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\WYNN5nw\WYNN.exe or C:\WYNN5nw\WYNNR.exe</td>
<td>UDP</td>
<td>5093</td>
<td>5093</td>
</tr>
</tbody>
</table>
Activating the License Server through a Software Firewall

<table>
<thead>
<tr>
<th>File Name</th>
<th>Connection Type</th>
<th>Incoming Port</th>
<th>Outgoing Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\WYNN5nw\WYNN.exe or C:\WYNN5nw\WYNNR.exe</td>
<td>UDP</td>
<td>5094</td>
<td>5094</td>
</tr>
<tr>
<td>C:\WYNN5nw\WYNN.exe or C:\WYNN5nw\WYNNR.exe (Only required if using redundant license servers)</td>
<td>UDP</td>
<td>5096</td>
<td>5096</td>
</tr>
<tr>
<td>C:\Program Files\Freedom Scientific\Activator\1.1\CAUtil.dll</td>
<td>TCP/IP</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>C:\Program Files\Freedom Scientific\Activator\1.1\CAUtil.dll</td>
<td>TCP/IP</td>
<td>20</td>
<td>21</td>
</tr>
<tr>
<td>C:\WYNN5nw\FSAuth.exe</td>
<td>UDP</td>
<td>5093</td>
<td>5093</td>
</tr>
<tr>
<td>C:\Program Files\Freedom Scientific\Activator\1.1\FSActivate.exe</td>
<td>TCP/IP</td>
<td>80</td>
<td>80</td>
</tr>
</tbody>
</table>

If you cannot reconfigure the firewall, or if you still cannot activate the software, go to [www.FSActivate.com](http://www.FSActivate.com). Follow the instructions on the Web page to retrieve an Activation License code.
Finding your Locking Code

To use FSActivate.com, you need your Authorization number and the license server’s Locking code. Do the following to find the Locking code:

1. From the Start menu, choose Programs or All Programs, Freedom Scientific, Network, and Update WYNN Authorization.

2. Choose Start Activation.

3. If you are asked to insert your Authorization CD, specify that you want to enter the Authorization number manually.

4. Choose Activate.

5. Select the Telephone to Receive Activation by Mail option and press ENTER. The server's Locking code is shown on the page that appears.

6. After you copy the Locking code, choose Quit.

Configuring Windows Firewall

The following describes how to configure and open ports using Windows Firewall for use with WYNN5nw.

1. From the Start button, select Control Panel.

2. Select Windows Firewall, and then select the Exceptions tab.
3. Select the **Add Port** button, enter a name in the **Name** field (for example, UDP port 5093), enter port number 5093 in the **Port** field, and select the **UDP** radio button. Click **OK**.
Activating the License Server through a Software Firewall

UDP port 5093 now appears in the Programs and Services list box.

4. Repeat step 3 for the following ports:

<table>
<thead>
<tr>
<th>Port Number</th>
<th>Connection Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>5094</td>
<td>UDP</td>
</tr>
<tr>
<td>5096</td>
<td>UDP</td>
</tr>
<tr>
<td>80</td>
<td>TCP</td>
</tr>
</tbody>
</table>
5. From the **Exceptions** tab, click the **Add Program** button.

The Add a Program dialog box appears.

6. Click the **Browse** button, and locate and select the **FSActivate.exe** file.

For example:

```
C:\Program Files\Freedom Scientific\Activator\1.1\FSActivate.exe.
```

**FSActivate** now appears in the Programs list.
7. Select the **OK** button to close and save the Windows Firewall settings.
Quick Reference

**Note:** The following provides quick references for network administrators.

### User Permissions

<table>
<thead>
<tr>
<th>Folder</th>
<th>Permissions (Sharing Tab)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Full Control, Change, and Read</td>
</tr>
<tr>
<td>WYNN5nw</td>
<td>Change and Read</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Folder</th>
<th>NTFS Permissions (Security Tab)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Full Control</td>
</tr>
<tr>
<td>WYNN5nw</td>
<td>Read and Execute, List Folder Contents, and Read</td>
</tr>
<tr>
<td>License</td>
<td>Read and Execute, List Folder Contents, and Read</td>
</tr>
<tr>
<td>WYNN Reader/Wizard</td>
<td>Read and Execute, List Folder Contents, and Read</td>
</tr>
</tbody>
</table>
# Network Authorization tools

<table>
<thead>
<tr>
<th>Network Authorization Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Administration</td>
<td>Launches the WLMAdmin utility that allows you to monitor the license server and perform some administrative actions. For more information, refer to the <em>System Administrator’s Guide</em>.</td>
</tr>
</tbody>
</table>

**Note:** Freedom Scientific products are identified by the following product keys:

<table>
<thead>
<tr>
<th>Code</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>JAWS</td>
</tr>
<tr>
<td>10</td>
<td>MAGic</td>
</tr>
<tr>
<td>20</td>
<td>OpenBook</td>
</tr>
<tr>
<td>30</td>
<td>WYNN Wizard</td>
</tr>
<tr>
<td>40</td>
<td>WYNN Reader</td>
</tr>
</tbody>
</table>

<p>| Service Loader                    | Adds or removes the license server as a service called “SentinelLM” in your Windows NT System Service registry. On Windows NT systems, the license server must be running as a service in order to authorize client systems. |</p>
<table>
<thead>
<tr>
<th>Network Authorization Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Administrator’s Guide</td>
<td>Contains additional information on license management, installation, optional features, administrator commands, user options, and environment variables.</td>
</tr>
<tr>
<td>Uninstall Network Setup</td>
<td>Uninstalls Network Authorization documentation and tools and (optionally) the license server.</td>
</tr>
<tr>
<td>Update WYNN Authorization</td>
<td>Begins the activation process for your Freedom Scientific product.</td>
</tr>
</tbody>
</table>
WYNN Folders and Subfolders

*During product installation, the Users folder and its subfolders can be installed in another location besides the default WYNN5nw folder.

**This folder contains the WYNN template files, and it is also used for broadcasting files to WYNN client users.

***Each WYNN user has their own unique user folder for storing their documents on the WYNN Network Server (WYNN5nw).

<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WYNN5nw</td>
<td>Default Network WYNN folder.</td>
</tr>
<tr>
<td>WYNN WIZARD ENG</td>
<td>Default WYNN Wizard folder. In this example, ENG indicates English. The client setup is launched from this folder.</td>
</tr>
<tr>
<td>WYNN READER ENG</td>
<td>Default WYNN Reader folder, in this example ENG indicates English. The client setup is launched from this folder.</td>
</tr>
<tr>
<td><strong>Folder</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td>LICENSE</td>
<td>Contains the INI file that stores the location of all user default folders. This folder is required to run a WYNN client installation.</td>
</tr>
<tr>
<td>USERS</td>
<td>Contains all user folders that are created when a user initially logs on to WYNN. During installation, this folder can be renamed and saved to a new location on the server instead of WYNN5nw, the default Network folder. Note: The location where documents are stored must be shared before completing the installation. If</td>
</tr>
<tr>
<td>SHARED</td>
<td>This folder is shared among users on the network. It contains the subfolders Docs, Settings, and Audio. Files that are used for broadcasting are placed in these folders.</td>
</tr>
<tr>
<td>USER</td>
<td>An individual user’s folder that has the same label as the user’s log in ID.</td>
</tr>
<tr>
<td>DOCS</td>
<td>For the Shared folder, it contains all sample WYNN files. For the User folder, it contains the user’s saved files.</td>
</tr>
<tr>
<td>SETTINGS</td>
<td>For the Shared folder, it contains default and broadcast system settings. For the User folder, it contains new system settings created and saved by the user.</td>
</tr>
<tr>
<td>Folder</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>AUDIO</td>
<td>For the Shared folder, it contains MP3 and WAV files for broadcasting. For the User folder, it contains MP3 and WAV files saved by the user.</td>
</tr>
</tbody>
</table>
2-page scan, 115
activate
  by fax, 233
  by Internet, 19
  by telephone, 230
License Server, 241
  using Activation Media Image Creator, 240
  using FSActivate.com, 237
activating software, 19, 227, 229, 233, 237, 240, 241
Activation Media Image Creator, 240
Adjust, 99, 200
  adjusting outlines, 200
Advanced, 107
audio, 170
auditory processing, 148
Auditory toolbar, 179
Authorization CD, 16
Authorization code, 227
Authorization number, 16, 17, 227
Back, 101, 191
blue buttons, 1, 78
Bookmark, 94, 156, 173
  Bookmark Order, 93
  Bookmark Type, 93
broadcast, 128
broadcast documents, 129
broadcast settings, 131
browser, 82, 190
buttons
  Common, 1, 75
  File Management, 1, 78
  Reading Styles, 1, 83
  Study Tools, 1, 90
  Universal, 1, 75
  Writing Tools, 1, 96
changing colors, 168
changing voices, 67
cleaning up scanned text, 122
Clean-up, 82
Close, 80
Close Web, 191, 195
Color, 86
color scanning, 109
context-sensitive help, 12
correct word usage, 211
correcting scanned text, 122
creating bookmarks, 156
creating documents, 45
custom toolbars, 147
customer support, 14
Cut/Paste, 97, 172
default user folder, 42
definitions, 211
Dictionary, 90, 103, 176
doc, 46, 79
Document Clean-up, 122
Document Clean-up guidelines, 124
Dynamic Zoning, 119
Edit, 106
edit Word Prediction, 138
e-mail, 14
ETI-Eloquence, 67
Exact View, 57, 74, 77, 122
express batch scan, 112
F1 key, 11
Favorites, 191
File, 106
File Management, 78, 101, 202
Find, 98
firewall, 241, 243
Fluent Reading, 147
Forward, 191
Freedom Import Printer, 22, 48–50
FSActivate, 228
getting help, 10

Go To, 98

Go to Page, 191

Go To Web, 82

green buttons, 1, 83

hearing text, 148, 179

Help, 10, 107

Highlight, 92, 103

Highlight Color, 93, 104, 198

Highlight Order, 93, 104, 198

highlighting text, 158, 163, 183

History, 191

Home, 191

homophones, 100, 127, 211

how to

activate software, 19, 227

add to the word prediction list, 138

add words to pronunciation dictionary, 133

broadcast files, 129

broadcast settings, 131

change color settings, 167

change the speech rate, 62

change voices, 67

configure word prediction, 135

correct scanned text, 122

create a toolbar, 143

create a vocabulary toolbar, 151

create bookmarks, 156

hear text, 179

highlight text, 158, 183

listen to Voice Notes, 60, 187

log in, 42

make a voice note, 159

mask text, 188

move scanned text, 119

open other documents, 46

open Text Notes, 60

outline topics, 199
print, 163
read web pages, 190
read Web pages, 194
rearrange scanned text, 119
record a voice note, 159
restore Word Prediction lists, 139
save a file, 65
save toolbars, 145
scan, 52–55
select toolbars, 147
shade text, 188
HTML, 46
hyperlinks, 195, 196
increasing text size, 187
languages
reading, 125
scanning, 125
large batch scan, 110
License code, 238

Line Space, 64, 84
listening to Voice Notes, 187
Lists, 93, 104, 198
Locking code, 230, 237, 243
log in, 42–44
Log In Different User, 129, 131
making voice notes, 159
Margins, 85
Mask, 87
Masking, 188
masking web pages, 190
maximum open documents, 45, 51
menu bar, 105
MP3, 169
multi-user log in, 44
network version, 2
New, 79
Next, 76
NNMU, 15, 16, 17, 20
Non-Network Multi-User, 15
<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note, 95</td>
<td>258</td>
</tr>
<tr>
<td>OCR, 2</td>
<td>2</td>
</tr>
<tr>
<td>Online Help, 10</td>
<td>10</td>
</tr>
<tr>
<td>Open, 79</td>
<td></td>
</tr>
<tr>
<td>opening a new document using outlines, 199</td>
<td></td>
</tr>
<tr>
<td>opening a PDF file, 46</td>
<td></td>
</tr>
<tr>
<td>opening other documents, 46</td>
<td></td>
</tr>
<tr>
<td>Other Docs, 77, 105</td>
<td></td>
</tr>
<tr>
<td>Outlines, 98, 199</td>
<td></td>
</tr>
<tr>
<td>Pause, 76, 89</td>
<td></td>
</tr>
<tr>
<td>PDF, 46, 47, 79</td>
<td></td>
</tr>
<tr>
<td>personal default folder, 48</td>
<td></td>
</tr>
<tr>
<td>phonetic spelling, 204</td>
<td></td>
</tr>
<tr>
<td>pink buttons, 1, 90</td>
<td></td>
</tr>
<tr>
<td>Predict, 100</td>
<td></td>
</tr>
<tr>
<td>preset color combinations, 167</td>
<td></td>
</tr>
<tr>
<td>Print, 81</td>
<td></td>
</tr>
<tr>
<td>printing, 163</td>
<td></td>
</tr>
<tr>
<td>pronouncing words, 133</td>
<td></td>
</tr>
<tr>
<td>Pronunciation Dictionary, 133</td>
<td></td>
</tr>
<tr>
<td>proofreading, 203</td>
<td></td>
</tr>
<tr>
<td>Public Access, 148</td>
<td></td>
</tr>
<tr>
<td>Rate, 62, 89, 204</td>
<td></td>
</tr>
<tr>
<td>Read, 74, 76</td>
<td></td>
</tr>
<tr>
<td>read hyperlinks, 195</td>
<td></td>
</tr>
<tr>
<td>Read Only, 76</td>
<td></td>
</tr>
<tr>
<td>reading other languages, 125</td>
<td></td>
</tr>
<tr>
<td>reading speed, 62, 203</td>
<td></td>
</tr>
<tr>
<td>Reading Styles, 62, 64, 83, 187, 188</td>
<td></td>
</tr>
<tr>
<td>Reading toolbar, 154</td>
<td></td>
</tr>
<tr>
<td>reading web pages, 194</td>
<td></td>
</tr>
<tr>
<td>Readme file, 13</td>
<td></td>
</tr>
<tr>
<td>RealSpeak Solo, 67</td>
<td></td>
</tr>
<tr>
<td>recording voice notes, 159</td>
<td></td>
</tr>
<tr>
<td>Re-Define, 120</td>
<td></td>
</tr>
<tr>
<td>Refresh, 191</td>
<td></td>
</tr>
<tr>
<td>Re-Process, 122</td>
<td></td>
</tr>
<tr>
<td>requirements, 213</td>
<td></td>
</tr>
</tbody>
</table>
Retrieve Settings, 147
Revert, 121
rtf, 47, 79
SAPI 4 voices, 67
SAPI 5 voices, 67
Save, 65, 80
Save As, 66, 81
Save to Audio, 170
Scan, 52–55, 78, 106
scanning
  2-page, 115
before you scan, 108
clean-up, 122
difficult text, 118
express batch, 112
guidelines, 124
inserting a page, 54
languages, 125
large batch, 110
moving text, 119
multiple pages, 110
new document, 53
replacing current page, 55	tables, 117
text without charts, 116
text without pictures, 116
Search, 191
selecting voices, 67
Self-Pace, 88
serial number, 14
Settings, 107
shading text, 188
Shared, 129, 131
single-user, 2, 15, 20
Size, 83
Sound-alike Words, 211
Speak List, 100, 202
speech rate, 63
Speech Settings, 181
speech speed, 62
Spell, 91
Spell Check, 100
spelling, 205–10
spotlight, 56, 74
starting WYNN, 42
status bar help, 12
Status Bar Help, 12
Stop, 191
Study Tools, 90, 174, 183
Studying, 148
Style, 97
switching views, 57–59
syllables, 204
Syllables, 91
Synonyms, 179
technical support, 14
Text Note, 59, 95, 164
Text View, 58, 74, 77, 122
Thesaurus, 178
tools, 1, 75–105, 143, 148, 151, 154
txt, 46, 79
uninstall WYNN, 21
upgrade, 17
User Files, 47
user folder, 42
user interface, 11, 73
user name, 74
View, 106
vocabulary, 151
vocabulary list, 173
Voice Notes, 59, 96, 159, 161, 187
voices, 67
WAV, 169
Web, 82, 107
Web Settings, 193
Web site, 14
Web toolbar, 101, 190
WebMask, 102, 191
<table>
<thead>
<tr>
<th>Term</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>What's This? help</td>
<td>13</td>
</tr>
<tr>
<td>Windows</td>
<td>107</td>
</tr>
<tr>
<td>Word Prediction</td>
<td>135, 201</td>
</tr>
<tr>
<td>Word Prediction Edit List</td>
<td>138</td>
</tr>
<tr>
<td>Word Prediction Learning Text,</td>
<td>136</td>
</tr>
<tr>
<td>Word Prediction Lists</td>
<td>142</td>
</tr>
<tr>
<td>Word Prediction Phonetics</td>
<td>140</td>
</tr>
<tr>
<td>Word Space</td>
<td>64, 84</td>
</tr>
<tr>
<td>WPM</td>
<td>63</td>
</tr>
<tr>
<td>Write</td>
<td>74, 76</td>
</tr>
<tr>
<td>Writing Tools</td>
<td>96, 199</td>
</tr>
<tr>
<td>WYNN folder</td>
<td>48</td>
</tr>
<tr>
<td>WYNN Reader</td>
<td>2, 17, 39</td>
</tr>
<tr>
<td>WYNN Wizard</td>
<td>2, 17, 39</td>
</tr>
<tr>
<td>yellow buttons</td>
<td>1, 96</td>
</tr>
</tbody>
</table>